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Introduction

Nous vous remercions de votre mise à jour vers Sibelius 5. Nous sommes sûr que vous trouverez
cette mise à jour majeure plus rapide, plus intelligente et plus simple que jamais. Avec la nouvelle
fonction idées, vous pouvez capturer, organiser, adapter et réutiliser chaque mélodie, chaque motif
ou tout autre matériel musical que vous souhaitez et l’avoir toujours à votre disposition. Panorama
affiche votre partition sous forme d’un système continu se déroulant à l’infini, évitant de brider
votre créativité par des soucis de mise en page. Avec une nouvelle bibliothèque de sons et la possi-
bilité d’utiliser directement n’importe quel instrument virtuel ou effet dans Sibelius, vous pouvez
écouter votre partition d’une manière plus réaliste que jamais. Vous pouvez placer des répliques à
volonté dans les parties, changer d’instrument sur une portée, créer des pages de titre ou blanches
d’un simple clic, et ce n’est qu’un début!

Ce livret vous explique comment installer cette nouvelle version de Sibelius et en résume toutes les
améliorations. Consultez l’ouvrage de référence de Sibelius (cf. ci-dessous) pour prendre connais-
sance des nouvelles fonctions dans les moindres détails.

Nous vous recommandons fortement de lire ce livret en entier avant de procéder à la mise à jour.
Au minimum, il est indispensable de suivre les instructions figurant dans les pages suivantes.

L’ouvrage de référence de Sibelius
La documentation de Sibelius 5 se divise en deux: le manuel, qui explique aux nouveaux utili-
sateurs comment installer le programme et utiliser les fonctions de base, et l’ouvrage de référence,
qui explique chaque fonction du programme en détail. Comme vous procédez à une mise à jour, le
manuel de Sibelius 5 n’est pas inclus.

L’ouvrage de référence est disponible à l’écran dans Sibelius 5: choisissez Aide > Référence de
Sibelius (raccourci F1 ou X?), et il s’ouvrira dans Adobe Reader (Windows) ou Preview (Mac).

L’ouvrage de référence est aussi disponible en option sous forme de livre imprimé. Si vous souhai-
tez en acheter un exemplaire, rendez-vous sur www.sibelius.com/buy pour en savoir plus.

Voici les nouveautés et changements principaux apportés dans l’ouvrage de référence depuis Sibelius 4:

* 3. Texte et 7. Fichiers ont été réorganisés, avec un plus grand nombre d’articles moins longs
pour faciliter une recherche spécifique

* 5.4 Parties dynamiques devient un nouveau chapitre, 6. Parties, divisé en articles plus courts
* Toutes les nouvelles fonctions et améliorations font l’objet soit de nouveaux articles ou d’articles

existants mais fortement revus vers lesquels ce livret propose les renvois ad hoc.

Dans votre emballage de mise à jour 
En plus de ce livret, vérifiez si vous avez reçu les éléments suivants:

* le DVD-ROM Sibelius 5
* Un code de mise à jour (ou plusieurs codes, si vous possédez plusieurs exemplaires de Sibelius

avec chacun un numéro de série)
* Un feuillet intitulé Informations de dernière minute et assistance technique

* Un ouvrage de référence (si vous avez choisi de l’acheter avec votre mise à jour).
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Mise à jour sous Windows

Important
Si vous installez votre mise à jour sur l’ordinateur qui contient l’ancienne version de Sibelius:

* Ne désinstallez pas cette ancienne version avant de faire la mise à jour
* Vérifiez que l’exemplaire de Sibelius à mettre à jour est enregistré (pour Sibelius 2.x et Sibelius

1.x, il n’y a pas de fonction de sauvegarde de transfert vers un autre ordinateur). Vous pouvez
mettre à jour un exemplaire non enregistré de Sibelius, mais celui-ci ne sera pas enregistré après
la mise à jour.

Si vous installez la mise à jour sur un ordinateur différent de celui qui contient l’ancienne version de
Sibelius:

* Si vous faites la mise à jour de Sibelius 3 ou Sibelius 4, lancez l’ancienne version de Sibelius sur
votre vieil ordinateur et choisissez Aide > Désenregistrer Sibelius pour désenregistrer Sibelius
via Internet avant d’installer Sibelius 5 sur le nouvel ordinateur

* Si vous faites la mise à jour de Sibelius 2 ou Sibelius 1.4, désinstallez l’ancienne version de Sibelius
sur votre vieil ordinateur avant d’installer Sibelius 5 sur le nouvel ordinateur; cf. Désinstaller
des versions anciennes de Sibelius à la page 13.

Quellle que soit la version de Sibelius mise à jour, si vous installez Sibelius 5 sur un nouvel ordina-
teur, vous ne devez pas y installer l’ancienne version pour pouvoir installer la nouvelle.

Configurations minimales requises
Voici le minimum requis pour Sibelius 5 seul:

Windows XP SP2 ou Windows Vista, 512MB+ RAM, 350MB d’espace libre sur le disque dur, lec-
teur de DVD-ROM

Voici ce qu’il faut en plus pour utiliser Sibelius Sounds Essentials et Kontakt Player 2, surtout pour
les partitions avec beaucoup d’instruments:

1GB+ total RAM, 3.5GB d’espace libre sur le disque dur, une carte-sons compatible ASIO

Sans ceci, Sibelius Sounds Essentials est utilisable, mais pas avec plusieurs sons simultanés.

Vous devez être au minimum sous Windows XP Service Pack 2 pour installer et lancer Sibelius. Si
vous êtes sous Windows 95, Windows 98, Windows Me, Windows 2000 ou Windows NT 4.x, vous
devez acheter une mise à jour vers une version plus récente du système d’exploitation Windows.

Comment déterminer si vous êtes sous Windows XP Service Pack 2
Si vous êtes sous Windows XP voici comment déterminer si vous êtes ou non sous Windows XP
Service Pack 2:

* Cliquez sur le bouton démarrer, puis choisissez Exécuter...

* Tapez winver dans le cadre Ouvrir, puis tapez Retour (sur le clavier principal)
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* Voici le type de fenêtre qui devrait s’afficher:

Vous verrez Service Pack 2 à la fin de la seconde ligne de texte. S’il n’y est pas, c’est que vous devez
faire la mise à jour vers le Service Pack 2. La manière la plus simple consiste à le télécharger
automatiquement en choisissant dans le menu démarrer Windows Update (tous les pro-
grammes). Si l’ordinateur sur lequel vous voulez lancer Sibelius n’est pas connecté à Internet, vous
pouvez obtenir Windows XP Service Pack 2 sur CD-ROM ou par un chargement spécial via un
autre ordinateur dont le résultat sera gravé sur CD. Consultez http://www.microsoft.com/win-
dowsxp/sp2/default.mspx pour en savoir plus.

Utilisateurs Sibelius 1.x 
Si vous installez votre mise à jour sur le même ordinateur que celui qui contient l’ancienne version
de Sibelius, vérifiez qu’il s’agit de la version 1.2 ou ultérieure. Voici comment faire: lancez Sibelius,
ensuite choisissez Help > About Sibelius. Le numéro de version est affiché dans le coin inférieur
droit de la fenêtre qui apparaît.

Important: Si votre version est antérieure à 1.2:

* Quittez Sibelius, s’il fonctionne
* Insérez votre DVD-ROM Sibelius 5; après quelques instants, un menu apparaît. Cliquez sur Par-

courir ce DVD.
* Une fenêtre Windows Explorer va apparaître affichant le contenu du DVD-ROM. Faites un dou-

ble-clic sur le dossier Mise à jour de Sibelius 1.x vers 1.4, et enfin faites un double-clic sur
l’icône Mise à jour de Sibelius (English) pour mettre à jour votre version de Sibelius vers 1.4.

* Suivez les instruction à l’écran; il vous sera peut-être demandé de redémarrer. Si c’est le cas,
faites-le.

* Maintenant relancez Sibelius de nouveau pour vérifier si la mise à jour est réussie. Il est très
important que vous lanciez Sibelius avant de le mettre à jour!

* L’écran d’accueil devrait afficher “Version 1.4.” Si vous n’avez pas pu le voir, vérifiez la version de
nouveau dans Help > About Sibelius.

* Quittez Sibelius de nouveau.

Plusieurs exemplaires et licences réseau
Si vous possédez plusieurs exemplaires de Sibelius avec le même numéro de série, par exemple une
multi-licence pour cinq utilisateurs, une seconde installation ou un exemplaire sur portable, il suffit
de suivre les mêmes instructions pour chaque ordinateur, en utilisant le même numéro de mise à jour

http://www.microsoft.com/windowsxp/sp2/default.mspx
http://www.microsoft.com/windowsxp/sp2/default.mspx
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Si vous possédez plus d’un numéro de série (par exemple deux multi-licences pour cinq utili-
sateurs), suivez les instructions de mise à jour sur chaque ordinateur, en utilisant le code de mise à
jour qui s’applique au numéro de série de Sibelius utilisé pour l’ordinateur. Le code de mise à jour
de chaque boîte de mise à jour indique le numéro de série auquel il s’applique. Si vous n’êtes pas sûr
du numéro de série utilisé par l’ordinateur, ne vous inquiétez pas, Sibelius vous l’indiquera en
temps utile quand il vous demandera le code de mise à jour.

Si vous possédez une licence réseau, veuillez lire le livret séparé Installation et enregistre-
ment des licences réseau contenu dans la boîte de mise à jour.

Privilèges d’administrateur
Vous devez installer Sibelius en utilisant un compte d’utilisateur avec des privilèges d’administra-
teur. Pour pouvoir enregistrer Sibelius après l’avoir installé vous devez soit avoir un compte utili-
sateur d’administrateur ou pouvoir fournir un nom d’administrateur et un mot de passe au
moment où il vous sera demandé.

Par conséquent, nous vous recommandons d’agir en tant que utilisateur administrateur au
moment d’installer Sibelius 5, et par la suite pour le mettre en route et l’enregistrer (s’il ne l’’est pas).

Après avoir enregistré le programme, nous vous recommandons de lancer Sibelius (comme toutes
les autres applications) en tant qu’utilisateur sans privilège, pour accroître la sécurité de votre
système.

Si vous êtes la seule personne à utiliser l’ordinateur et que vous ignorez tout des comptes et privi-
lèges d’administrateur, vous pouvez oublier ce qui précède et installer le programme normalement.

Installer votre mise à jour
* Quittez toutes les applications en cours, y compris tout anti-virus chargé automatiquement au 

démarrage (comme par ex. McAfee Virus Scan ou Norton Antivirus). Si MSN Messenger se lance, 
quittez-le avant de lancer la mise à jour en faisant un clic-droit dans l’emplacement dédié au 
système (le coin inférieur droit du bureau Windows) et choisissez Terminer.

* Sortez le DVD-ROM Sibelius de son boîtier, placez-le (étiquette vers le haut) dans votre lecteur 
de DVD-ROM et fermez-en le tiroir.

* Patientez quelques instants. Le DVD-ROM devrait démarrer et une boîte de dialogue devrait 
apparaître à l’écran.

* (S’il n’y a aucun signe d’activité après un moment, cliquez sur le menu Démarrer, choisissez
Exécuter et tapez X:\autorun, X étant la lettre de votre lecteur de DVD-ROM, puis appuyez
Retour sur le clavier principal.)

* Cliquez sur Installer Sibelius 5 pour lancer la mise à jour de Sibelius
* Il vous sera peut-être demandé de charger et d’installer l Microsoft .NET Framework 2.0 avant

de lancer l’installation. Cliquez sur J’accepte pour accepter les termes du contrat de licence
affiché, et attendez patiemment que .NET Framework soit installé. Cela peut durer quelques
minutes.

* Après quelques secondes, une fenêtre apparaîtra affichant Bienvenue dans l’assistant
d’installation de Sibelius. Cliquez sur Suivant.
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* La possibilité vous est alors offerte de lire le contrat de licence de Sibelius qui est également
imprimé à la fin de ce guide de l’utilisateur. Cliquez sur J’accepte, puis cliquez sur Suivant.

* Le programme d’installation suggère un dossier dans lequel installer Sibelius. A moins d’être sûr
de ce que vous faites et de maîtriser une manœuvre alternative vous devriez laisser intact ce
réglage par défaut. Il vous sera demandé ensuite si vous voulez installer Sibelius pour tous les
utilisateurs ou Moi uniquement, qui détermine si tous les utilisateurs de votre ordinateur ver-
ront un raccourci vers Sibelius sur le bureau, ou seulement vous. Nous vous recommandons de
laisser tous les utilisateurs. Cliquez sur Suivant.

* L’installateur vous indiquera que Sibelius est prêt à être installé. Cliquez sur Suivant.
* Le processus peut prendre quelques minutes durant lesquelles se produisent à l’écran divers flashs 
* Quand l’installateur a terminé, cliquez sur Terminer.

Avant de lancer Sibelius 5 pour la première fois, voyez si vous ne devez pas installer d’autres appli-
cations depuis le DVD-ROM.

Installer Sibelius Sounds Essentials
Sibelius Sounds Essentials est une bibliothèque de sons de haute qualité à utiliser avec Sibelius – cf.
Sibelius Sounds Essentials à la page 28 pour en savoir plus. Pour l’installer:

* Si la fenêtre apparue lors de l’insertion du DVD-ROM de Sibelius 5 est toujours ouverte, cliquez
sur Installer Sibelius Sounds Essentials dans cette fenêtre pour commencer. Si la fenêtre a dis-
paru, réinsérez le DVD-ROM de Sibelius 5, et elle reviendra à l’écran après quelques instants.

* Au bout d’un petit moment, l’installateur va démarrer. Cliquez sur Suivant.
* Le contrat de licence vous est proposé. Lisez-le et cliquez sur J’accepte.
* Vous serez informé que l’installation de la bibliothèque de sons va prendre du temps, et qu’à tout

moment le processus peut être arrêté. Cliquez sur Suivant.
* La question suivante concerne l’emplacement d’installation de Kontakt Player 2, le lecteur

d’échantillons. Il est recommandé d’accepter l’emplacement par défaut et donc il suffit de cliquer
sur Suivant.

* Cette fois il vous est demandé où les sons Kontakt Player doivent être installés. Vu la taille (envi-
ron 3GB), si vous n’avez pas assez d’espace sur votre disque dur principal, vous serez peut-être
amené à choisir un autre endroit. Autrement, il suffit de cliquer sur Suivant

* La question suivante concerne l’emplacement d’installation de l’instrument virtuel Kontakt Player
2 VST. L’emplacement par défaut devrait être C:\Program Files\Sibelius Software\VSTPlu-
gins, et mieux vaut ne pas le changer. Cliquez sur Suivant.

* Enfin une nouvelle question concerne le nom du groupe du menu démarrer dans lequel
s’ajoutera l’icône de Sibelius Sounds Essentials. Cliquez simplement sur Suivant.

* Maintenant des flashes traversent l’écran pendant que Sibelius Sounds Essentials s’installe. Vous
remarquerez que l’affichage Temps restant indique 0 seconde ou un peu plus, ce qui est nor-
mal. Cela peut prendre quelques minutes, donc un peu de patience.

* Finalement vous êtes informé que Sibelius Sounds Essentials a été installé avec succès. Cliquez
sur Terminer.
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Installer Scorch
À ce stade, vous devriez installer la dernière version de Scorch, l’extension gratuite pour navigateur
Internet qui permet d’afficher, d’exécuter, de transposer et d’imprimer des partitions Sibelius
présentes sur Internet:

* Si la fenêtre apparue lors de l’insertion du DVD-ROM de Sibelius 5 est toujours ouverte, cliquez
sur Installer Scorch dans cette fenêtre pour commencer. Si elle a disparu, réinsérez le DVD-
ROM de Sibelius 5, et elle reviendra à l’écran après quelques instants.

* Après quelques instants, une fenêtre apparaît avec le message Bienvenue dans l’assistant
d’installation de Sibelius Scorch. Cliquez sur Suivant.

* Le contrat de licence de Scorch vous est proposé. Lisez-le et cliquez sur J’accepte, puis cliquez 
sur Suivant.

* Il vous est demandé ensuite de choisir un dossier d’installation pour Scorch. De nouveau, il suffit
de cliquer sur Suivant.

* Un message vous indique que tout est prêt pour l’installation de Scorch. Cliquez sur Suivant.
* Maintenant des flashes traversent l’écran pendant que Scorch s’installe. Cela peut prendre

quelques instants
* Quand l’installateur a terminé, cliquer sur Terminer.

Installer PhotoScore Lite
Vous devriez maintenant installer la dernière version de PhotoScore Lite présente sur votre DVD-
ROM Sibelius 5, sauf si vous avez une version de Photoscore Ultimate (ou une version antérieure
de PhotoScore Professional) déjà installée:

* Si la fenêtre apparue lors de l’insertion du DVD-ROM de Sibelius 5 est toujours ouverte, cliquez
sur Installer PhotoScore Lite dans cette fenêtre pour commencer. Si elle a disparu, réinsérez le
DVD-ROM de Sibelius 5, et elle reviendra à l’écran après quelques instants.

* Si votre résolution d’écran est plus petite que 1024 x 768, un message s’affichera vous recom-
mandant de l’augmenter. Cliquez simplement sur OK.

* Cliquez ensuite sur Suivant pour voir le contrat de licence de PhotoScore Lite. Lisez-le et cliquez 
sur Suivant

* Répondez maintenant à quelques questions et tapez votre Nom; Le champ N° de produit est
déjà complété. Quand tout est rempli, cliquez sur Suivant.

* PhotoScore Lite vous indique où il sera installé; de nouveau, si vous savez ce que vous faites vous
pouvez changer d’emplacement. Sinon cliquez sur Suivant.

* Cliquez sur Suivant une fois de plus et PhotoScore Lite sera installé, puis cliquez sur Terminer.

Mise à jour de produits Sibelius Sounds 
Si vous possédez Kontakt Gold (qui s’appelle maintenant Sibelius Sounds Gold), Garritan Personal
Orchestra Sibelius Edition ou Sibelius Rock and Pop Collection, vous devez en faire la mise à jour
en même temps que Sibelius 5. Vous pouvez télécharger la mise à jour gratuite de ces produits sur
le site web de Sibelius:

http://www.sibelius.com/products/sibelius_sounds/upgrade.html

http://www.sibelius.com/products/sibelius_sounds/upgrade.html
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Premier lancement
Le premier lancement de Sibelius achève la procédure de mise à jour. Lancez Sibelius 5 soit en fai-
sant un double-clic sur son icône présente sur le bureau, ou en choisissant Démarrer > Tous les
programmes > Sibelius Software > Sibelius 5. Voici ce qui apparaîtra:

* Si vous n’avez pas ouvert la session en tant qu’administrateur, il vous sera demandé un nom
d’utilisateur et un mot de passe. Si vous êtes administrateur sous Windows Vista, il vous sera
demandé votre permission pour continuer. Donnez les éléments nécessaires pour pouvoir con-
tinuer la procédure.

* Il vous sera demandé si vous possédez une version enregistrée de Sibelius installée sur votre
ordinateur.
Si vous avez installé votre mise à jour sur le même ordinateur qui contient votre version précé-
dente de Sibelius, cliquez Oui, ensuite:
% Sibelius affichera une liste de tous les exemplaires de Sibelius installé sur votre ordinateur.

Normalement vous verrez uniquement un seul exemplaire (c’est-à-dire l’exemplaire de Sibe-
lius dont vous faites la mise à jour); choisissez-le et cliquez sur OK.

% La boîte de dialogue Entrer le code de mise à jour apparaît. Donnez votre nom et entrez le
code de mise à jour. Le code de mise à jour est imprimé sur une feuille de papier à l’intérieur
de votre boîte de mise à jour; tapez-le et cliquez sur OK. Si vous avez plusieurs numéros de
série et plusieurs codes de mise à jour, vérifiez que le code de mise à jour que vous entrez cor-
respond bien au numéro de série. (De toutes façons, il vous sera notifié s’il est faux)

% Cliquez sur OK, et l’écran de bienvenue de Sibelius 5 va réapparaître.
Si, par contre vous avez installé la mise à jour sur un ordinateur différent de celui sur lequel est
installé la version précédente de Sibelius, cliquez sur Non, puis:
% Remplissez le numéro de série de Sibelius qui vous est demandé. Vous le trouverez au dos du

boîtier CD de la version originale de Sibelius que vous possédez; ce numéro commence par S.
% Cliquez sur OK, et l’écran d’accueil de Sibelius 5 apparaîtra.
% Il vous est ensuite proposé d’enregistrer Sibelius. Vous devriez réaliser cette opération immé-

diatement; donc choisissez le bouton par Internet et cliquez sur Suivant, puis suivez les
instruction à l’écran. Si vous avez besoin d’aide pour enregistrer Sibelius, consultez Enregis-
trer Sibelius dans le manuel.

% Un message vous informe que Sibelius est enregistré avec succès.
* Dès que Sibelius est chargé, la boîte de dialogue Démarrage rapide apparaît. Désactivez

Afficher cet écran à chaque démarrage de Sibelius si cette fenêtre vous gêne.

Dès que vous avez terminé d’installer Sibelius, rangez votre DVD-ROM Sibelius 5 dans le boîtier de
votre CD-ROM Sibelius, et jetez tous les vieux CD-ROM de Sibelius (car désormais ils ne servent
plus à rien). Il est important de placer le nouveau DVD dans le vieux boîtier, car c’est sur ce boîtier
qu’est imprimé le numéro de série.

Restaurer d’anciens fichiers
Utilisateurs expérimentés uniquement

Il se peut que vous ayez écrit ou personnalisé des extensions, du papier à musique, des jeux de
fonctions, des styles “arranger”, etc... dans des versions précédentes de Sibelius. Chaque version de
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Sibelius conserve ces fichiers dans des emplacements différents, si bien que, si vous voulez les uti-
liser dans Sibelius 5, il faut les copier manuellement de leur emplacement vers le nouveau qui con-
vient. Pour connaître l’emplacement dans lequel Sibelius 5 place les fichiers créés par les
utilisateurs:

* Faites un double-clic sur Mon ordinateur et ouvrez une fenêtre de l’explorateur Windows 
* Choisissez Outils > Options des dossiers, et cliquez sur l’onglet Affichage

* Dans Paramètres avancés, vérifiez que Afficher les fichiers et dossiers cachés est sélec-
tionné

* Cliquez sur OK pour fermer la boîte de dialogue Options des dossiers

* Naviguez jusqu’au dossier approprié de votre version de Windows:
% Windows XP: C:\Documents and Settings\username\Application Data\

% Windows Vista: C:\Users\username\AppData\Roaming\

* Si vous y voyez un dossier intitulé Sibelius Software, faites un double-clic dessus pour l’ouvrir.
Si vous ne voyez pas ce dossier, choisissez Fichier > Nouveau dossier, tapez comme nom de
dossier Sibelius Software, et faites un double-clic dessus pour l’ouvrir.

* Choisissez de nouveau Fichier > Nouveau dossier, et tapez comme nom de dossier Sibelius 5.
Faites un double-clic sur ce nouveau dossier pour l’ouvrir.

Il s’agit de l’emplacement dans lequel Sibelius 5 s’attend à trouver des dossiers personnalisés tels
que les extensions, les papiers à musique, etc., chaque type de composant ayant son propre dossier.

Si vous faites la mise à jour depuis Sibelius 4 et que vous avez modifié l’un de ces fichiers, vous avez
déjà au même endroit un dossier appelé Sibelius 4. Vous pouvez simplement faire glisser les dos-
siers du dossier Sibelius 4 dans votre dossier Sibelius 5.

Si vous faites la mise à jour depuis Sibelius 1, Sibelius 2 ou Sibelius 3, vous devez déplacer unique-
ment les fichiers personnalisés (et ceux que vous désirez conserver) de leur ancien emplacement vers
le nouveau de la manière suivante:

La plupart de ces anciens dossiers n’existaient pas avec Sibelius 1, de sorte que si vous faites la mise
à jour depuis cette version vous n’avez rien à faire.

Quelque soit la version mise à jour, notez que:

Types de composants Ancien emplacement:
C:\Program Files\Sibelius Software\
Sibelius 3\

Emplacement dans Sibelius 5:
...\Sibelius Software\Sibelius 5\

Styles arranger Styles arranger\ Styles arranger\

Styles maison Styles maison\ Styles maison\

Papier à musique Papier à musique\ Papier à musique\

Jeux de fonctions Menus et raccourcis\ Menus et raccourcis\

Extensions Extensions\ Extensions\

Modèles web Scorch Papier à musique\ Modèles Scorch\

Textures Textures\ Textures\
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* à cause des changements apportés à ManuScript, les extensions que vous avez créées ou modi-
fiées vous-même ne fonctionnent plus dans Sibelius 5; consultez la documentation de Manu-
Script dans le dossier Extras pour en savoir plus.

* à cause des changements apportés aux jeux de sons, les jeux de sons créés dans une version
antérieure à Sibelius 5 ne fonctionnent plus dans cette dernière version.

* pour profiter des nouvelles fonctions de Sibelius 5, vous devez importer un des nouveaux styles
maison dans vos partitions existantes et dans vos papiers à musique, ou recréer ex nihilo vos
propres papiers à musique.

Désinstaller des versions anciennes de Sibelius
Comme votre exemplaire précédent de Sibelius 1.x, 2.x, 3.x ou 4.x est toujours présent sur votre
ordinateur, mais n’est plus enregistré, nous vous recommandons de le désinstaller. Pour désin-
staller Sibelius, allez dans Démarrer > Panneau de configuration, et faites un double-clic sur
Ajouter/Supprimer des programmesPrograms.

Vous devriez voir l’une de ces versions dans l’ordre, Sibelius, Sibelius 2, Sibelius 3 ou Sibelius 4,
et enfin Sibelius 5; sélectionnez l’ancienne version et faites un clic sur Changer/Supprimer.
Veillez à ne pas sélectionner Sibelius 5 ce qui supprimerait la nouvelle version. Suivez ensuite les
instruction à l’écran pour désinstaller la vieille version.
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Mise à jour sur Mac

Important
Si vous installez votre mise à jour sur l’ordinateur qui contient l’ancienne version de Sibelius:

* Ne désinstallez pas cette ancienne version avant de faire la mise à jour
* Vérifiez que l’exemplaire de Sibelius à mettre à jour est enregistré (pour Sibelius 2.x et Sibelius

1.x, il n’y a pas de fonction de sauvegarde de transfert vers un autre ordinateur). Vous pouvez
mettre à jour un exemplaire non enregistré de Sibelius, mais celui-ci ne sera pas enregistré après
la mise à jour.

Si vous installez la mise à jour sur un ordinateur différent de celui qui contient l’ancienne version de
Sibelius:

* Si vous faites la mise à jour de Sibelius 3 ou Sibelius 4, lancez l’ancienne version de Sibelius sur
votre vieil ordinateur et choisissez Aide > Désenregistrer Sibelius pour désenregistrer Sibelius
via Internet avant d’installer Sibelius 5 sur le nouvel ordinateur

* Si vous faites la mise à jour de Sibelius 2 ou Sibelius 1.4, désinstallez l’ancienne version de Sibelius
sur votre vieil ordinateur avant d’installer Sibelius 5 sur le nouvel ordinateur; cf. Désinstaller
des versions anciennes de Sibelius à la page 19.

Quellle que soit la version de Sibelius mise à jour, si vous installez Sibelius 5 sur un nouvel ordina-
teur, vous ne devez pas y installer l’ancienne version pour pouvoir installer la nouvelle.

Configurations minimales requises
Sibelius 5 est une application universelle, ce qui signifie qu’il fonctionne à la fois sur
les vieux Macs avec processeur PowerPC et les nouveaux Macs avec processeur Intel.

Voici le minimum requis pour Sibelius seul:

Mac OS X 10.4 Tiger ou plus, 512MB+ RAM, 350MB de libre sur le disque dur, lecteurDVD-ROM 

Voici ce qu’il faut en plus pour utiliser Sibelius Sounds Essentials et Kontakt Player 2, surtout pour
les partitions avec beaucoup d’instruments:

G5 ou processeur Intel, 1GB+ total RAM, 3.5GB de libre sur le disque dur.

Sans ceci, Sibelius Sounds Essentials est utilisable, mais pas avec plusieurs sons simultanés.

Si vous êtes sous un système Mac OS X précédent Mac OS X 10.4, vous ne pourrez installer et
lancer Sibelius. Il vous faudra faire une mise à jour de Mac OS X, soumise à des frais. Consultez
www.apple.com pour en savoir plus.

Il est recommandé d’être sous la version la plus récente de Mac OS X pour utiliser Sibelius. Ouvrez
le panneau Mise à jour des applications des Préférences du système pour vérifier si vous uti-
lisez la dernière version.
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Comment déterminer si vous êtes sous Mac OS X 10.4 Tiger ou plus
Choisissez À propos de ce Mac dans le menu Pomme. Voici la fenêtre qui devrait s’afficher:

Sous le grand intitulé Mac OS X, devrait s’afficher quelque chose comme Version 10.4.9. Pourvu
que la première partie soit 10.4 ou plus, vous êtes sous Mac OS X 10.4 Tiger ou une nouvelle ver-
sion de Mac OS X, et vous pouvez installer et lancer Sibelius 5.

Plusieurs exemplaires et licences réseau
Si vous possédez plusieurs exemplaires de Sibelius avec le même numéro de série, par exemple une
multi-licence pour cinq utilisateurs, une seconde installation ou un exemplaire sur portable, il suf-
fit de suivre les mêmes instructions pour chaque ordinateur, en utilisant le même numéro de mise
à jour.

Si vous possédez plus d’un numéro de série (par exemple deux multi-licences pour cinq utili-
sateurs), suivez les instructions de mise à jour sur chaque ordinateur, en utilisant le code de mise à
jour qui s’applique au numéro de série de Sibelius utilisé pour l’ordinateur. Avec le code de mise à
jour présent dans chaque boîte de mise à jour se trouve le numéro de série auquel il s’applique. Si
vous n’êtes pas sûr du numéro de série utilisé par l’ordinateur, ne vous inquiétez pas, Sibelius vous
l’indiquera au moment de vous demander le code de mise à jour.

Si vous possédez une licence réseau, veuillez lire le livret séparé Installation et enregistre-
ment des licences réseau contenu dans la boîte de mise à jour.

Privilèges d’administrateur
Pour pouvoir installer correctement Sibelius 5 et l’enregistrer, vous devez lancer votre ordinateur
en utilisant un compte d’utilisateur avec des privilèges d’administrateur.

Par conséquent, nous vous recommandons d’agir en tant que utilisateur administrateur au
moment d’installer Sibelius 5, et par la suite pour le mettre en route et l’enregistrer (s’il ne l’’est pas).

Après avoir enregistré le programme, nous vous recommandons de lancer Sibelius (comme toutes
les autres applications) en tant qu’utilisateur sans privilège, pour accroître la sécurité de votre
système.

Si vous êtes la seule personne à utiliser l’ordinateur et que vous ignorez tout des comptes et privi-
lèges d’administrateur, vous pouvez oublier ce qui précède et installer le programme normalement.
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Installer votre mise à jour
* Sortez le DVD-ROM Sibelius de son boîtier, placez-le (étiquette vers le haut) dans votre lecteur

de DVD-ROM et fermez-en le tiroir.
* Patientez quelques instants. Une icône représentant le DVD, intitulé Sibelius 5, devrait apparaî-

tre sur votre bureau, et une fenêtre contenant d’autres icônes devrait s’ouvrir automatiquement;
si tel n’est pas le cas, double-cliquez sur l’icône Sibelius 5.

* Pour installer votre mise à jour, déplacez simplement l’icône Sibelius 5 du DVD vers le dossier
Applications du disque dur de votre Mac. Ne faites pas de double-clic sur l’icône de Sibelius 5
dans la fenêtre du DVD, car Sibelius ne fonctionnera pas correctement s’il est lancé directement
depuis le DVD-ROM.

Une barre de progression va apparaître pendant l’installation de l’application sur votre disque dur,
qui peut prendre un certain temps; sa disparition signifie que Sibelius a été installé avec succès

Avant de lancer Sibelius 5 pour la première fois, voyez si vous ne devez pas installer d’autres appli-
cations depuis le DVD-ROM.

Installer Sibelius Sounds Essentials
Sibelius Sounds Essentials est une bibliothèque de sons de haute qualité à utiliser avec Sibelius – cf.
Sibelius Sounds Essentials à la page 28 pour en savoir plus. Pour l’installer:

* Insérez le DVD-ROM de Sibelius 5, s’il n’est plus dans le lecteur.
* Faites un double-clic sur Installer Sibelius Sounds Essentials pour lancer l’installation.
* Donnez votre mot de passe d’administrateur qui vous est demandé, puis cliquez sur OK.
* Après quelques instants, il vous est demandé de choisir un emplacement pour installer Kontakt

Player 2. Par défaut il se crée un dossier appelé Kontakt Player 2 à l’intérieur du dossier Appli-
cations sur le disque dur principal de votre Mac. Cliquez sur Continuer sauf si vous avez une
bonne raison de le placer ailleurs.

* Ensuite il vous est demandé de choisir entre Easy Install (installation simple) ou Custom
Install (installation personnalisée). Laissez le réglage sur Easy Install et cliquez sur Install.

* Une barre de progression s’affiche au milieu de l’écran pendant que la bibliothèque s’installe.
Cela peut prendre plusieurs minutes, donc soyez patient, même si rien ne semble se passer.

* Enfin l’installation est terminée! Cliquez sur Quit pour fermer l’assistant d’installation.

Installer Scorch
À ce stade, vous devriez installer la dernière version de Scorch, l’extension gratuite pour navigateur
Internet qui permet d’afficher, d’exécuter, de transposer et d’imprimer des partitions Sibelius
présentes sur Internet. Faites un double-clic sur le dossier Autres Applications dans la fenêtre du
DVD Sibelius 5. Une autre fenêtre avec de petites icônes va apparaître. Faites un double-clic sur
Installer Scorch:

* Votre mot de passe d’administrateur de l’ordinateur vous est demandé. Tapez-le, et cliquez sur OK.
* Le contrat de licence de Scorch vous est proposé. Lisez-le et cliquez sur J’accepte, puis cliquez 

sur Suivant.
* Sur l’écran suivant il suffit de cliquer sur Installer
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* Une barre de progression s’affiche à travers l’écran et vous êtes informé que l’installation s’est
déroulée avec succès. Cliquez sur Quitter.

Installer PhotoScore Lite
Vous devriez maintenant installer la dernière version de PhotoScore Lite présente sur votreDVD-
ROM Sibelius 5, sauf si vous avez une version de Photoscore Ultimate (ou une version antérieure
de PhotoScore Professional) déjà installée. Faites un double-clic sur le dossier Autres Applica-
tions dans la fenêtre du DVD Sibelius 5. Une autre fenêtre avec de petites icônes va apparaître.
Faites un double-clic sur Installer PhotoScore Lite:

* Le contrat de licence de PhotoScore Lite vous est proposé. Lisez-le et cliquez sur J’accepte

* Sur l’écran suivant il suffit de cliquer sur Installer

* Une barre de progression s’affiche à travers l’écran et vous êtes informé que l’installation s’est
déroulée avec succès. Cliquez sur Quitter.

Mise à jour de produits Sibelius Sounds 
Si vous possédez Kontakt Gold (qui s’appelle maintenant Sibelius Sounds Gold), Garritan Personal
Orchestra Sibelius Edition ou Sibelius Rock and Pop Collection, vous devez faire leur mise à jour
en même temps que Sibelius 5. Vous pouvez télécharger la mise à jour gratuite de ces produits sur
le site web de Sibelius:

http://www.sibelius.com/products/sibelius_sounds/upgrade.html

Premier lancement
Le premier lancement de Sibelius achève la procédure de mise à jour. Lancez Sibelius 5 soit en fai-
sant un double-clic sur l’icône Sibelius 5 dans le dossier Applications:

* Votre mot de passe d’administrateur de l’ordinateur vous est demandé. Tapez-le, et cliquez sur OK.
* Le Contrat de licence de Sibelius s’affiche. Lisez-le et cliquez sur J’accepte.
* Il vous sera demandé si vous possédez une version enregistrée de Sibelius installée sur votre

ordinateur.
Si vous avez installé votre mise à jour sur le même ordinateur que celui qui contient déjà votre
ancienne version de Sibelius, cliquez Oui; ensuite:
% Sibelius affichera une liste de tous les exemplaires de Sibelius installé sur votre ordinateur.

Normalement vous verrez uniquement un seul exemplaire (c’est-à-dire l’exemplaire de Sibe-
lius dont vous faites la mise à jour); choisissez-le et cliquez sur OK.

% La boîte de dialogue Entrer le code de mise à jour apparaît. Donnez votre nom et entrez le
code de mise à jour. Le code de mise à jour est imprimé sur une feuille de papier à l’intérieur
de votre boîte de mise à jour; tapez-le et cliquez sur OK. Si vous avez plusieurs numéros de
série et plusieurs codes de mise à jour, vérifiez que le code de mise à jour que vous entré cor-
respond bien au numéro de série. (De toutes façons, il vous sera notifié s’il est faux)

% Cliquez sur OK, et l’écran de bienvenue de Sibelius 5 va réapparaître.
Si, par contre vous avez installé la mise à jour sur un ordinateur différent de celui sur lequel est
installé la version précédente de Sibelius, cliquez sur Non, puis:
% Remplissez le numéro de série de Sibelius qui vous est demandé. Vous le trouverez au dos du

boîtier CD de la version originale de Sibelius que vous possédez; ce numéro commence par S.

http://www.sibelius.com/products/sibelius_sounds/upgrade.html


Installation

18

% Cliquez sur OK, et l’écran de bienvenue de Sibelius 5 apparaîtra.
% Il vous est ensuite proposé d’enregistrer Sibelius. Vous devriez réaliser cette opération immé-

diatement, puis choisir le bouton par Internet et cliquez sur Suivant, puis suivez les instruc-
tions à l’écran. Si vous avez besoin d’aide pour enregistrer Sibelius, consultez Enregistrer
Sibelius dans le manuel.

* Dès que Sibelius est chargé, la boîte de dialogue Démarrage rapide apparaît. Désactivez
Afficher cet écran à chaque démarrage de Sibelius si cette fenêtre vous gêne.

Dès que vous avez terminé d’installer Sibelius, rangez votre DVD-ROM Sibelius 5 dans le boîtier de
votre CD-ROM Sibelius, et jetez tous les vieux CD-ROM de Sibelius (car désormais ils ne servent
plus à rien). Il est important de placer le nouveau DVD dans le vieux boîtier, car c’est sur ce boîtier
qu’est imprimé le numéro de série.

Restaurer d’anciens fichiers
Utilisateurs expérimentés uniquement

Il se peut que vous ayez écrit ou personnalisé des extensions, du papier à musique, des jeux de
fonction, des styles “arranger”, etc... dans des versions précédentes de Sibelius. Chaque version de
Sibelius conserve ces fichiers dans des emplacements différents, si bien que si vous voulez les uti-
liser dans Sibelius 5, il faut les copier manuellement de leur emplacement vers le nouveau qui con-
vient. Pour connaître l’emplacement dans lequel Sibelius 5 place les fichiers créés par les
utilisateurs:

* Ouvrez une nouvelle fenêtre du Finder
* Naviguez jusqu’à /Users/username/Library/Application Support

* Si vous y voyez un dossier Sibelius Software, faites un double-clic pour l’ouvrir. Si vous ne le
voyez pas, tapez xXN pour créer un nouveau dossier et tapez Sibelius Software comme nom
de dossier. Faites un double-clic dessus pour l’ouvrir.

* Tapez xXN de nouveau, et tapez Sibelius 5 comme nom de dossier. Faites un double-clic des-
sus pour l’ouvrir.

Il s’agit de l’emplacement dans lequel Sibelius 5 s’attend à trouver des dossiers personnalisés tels
que les extensions, les papiers à musique, etc., chaque type de composant ayant son propre dossier.

Si vous faites la mise à jour depuis Sibelius 4 et que vous avez modifié l’un de ces fichiers, vous avez
déjà au même endroit un dossier appelé Sibelius 4. Vous pouvez simplement faire glisser les dos-
siers du dossier Sibelius 4 dans votre dossier Sibelius 5.

Si vous faites la mise à jour depuis Sibelius 1, Sibelius 2 ou Sibelius 3, vous devez déplacer unique-
ment les fichiers personnalisés (et ceux que vous désirez conserver) de leur ancien emplacement vers
le nouveau de la manière suivante:
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La plupart de ces anciens dossiers n’existaient pas pour Sibelius 1, de sorte que si vous faites la mise
à jour depuis cette version vous n’avez rien à faire.

Quelque soit la version mise à jour, notez que:

* à cause des changements apportés à ManuScript, les extensions que vous avez créées ou modi-
fiées vous-même ne fonctionnent plus dans Sibelius 5; consultez la documentation de Manu-
Script dans le dossier Extras pour en savoir plus.

* à cause des changements apportés aux jeux de sons, les jeux de sons créés dans une version
antérieure à Sibelius 5 ne fonctionnent plus dans cette dernière version.

* pour profiter des nouvelles fonctions de Sibelius 5, vous devez importer un des nouveaux styles
maison dans vos partitions existantes et dans vos papiers à musique, ou recréer ex nihilo vos
propres papiers à musique.

Désinstaller des versions anciennes de Sibelius
Comme votre exemplaire précédent de Sibelius 1.x, 2.x, 3.x ou 4.x est toujours présent sur votre
ordinateur, mais n’est plus enregistré, nous vous recommandons de le désinstaller.

Si vous faites la mise à jour depuis Sibelius 2, faites attention au fait que l’emplacement par défaut
des partitions que vous avez créées est le dossier Partitions qui se trouve à l’intérieur du dossier de
l’application Sibelius 2. Donc avant de désinstaller Sibelius 2, déplacez d’abord votre dossier Par-
titions à un endroit où vous êtes certain que vos partitions ne seront pas supprimées!

Cherchez maintenant l’ancien dossier (dont le nom probable est Sibelius 2 ou Sibelius 3) ou
l’icône de l’application Sibelius 4 et mettez-le à la poubelle.

Component type Old location:
/Applications/Sibelius 3/

Sibelius 5 location:
/Users/username/Library/Application Sup-
port/Sibelius Software/Sibelius 5/

Styles arranger Styles arranger\ Styles arranger\

Styles maison Styles maison\ Styles maison\

Papier à musique Papier à musique\ Papier à musique\

Jeux de fonctions Menus et raccourcis\ Menus et raccourcis\

Extensions Extensions\ Extensions\

Modèles web Scorch Papier à musique\ Modèles Scorch\

Sound sets Sounds/ Sounds/

Textures Textures/ Textures/
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Mise à jour de partitions existantes

Quand vous ouvrez dans Sibelius 5 une partition qui a été sauve-
gardée dans une partition créée avec une version précédente, une
boîte de dialogue Mise à jour de la partition semblable à celle
illustrée à gauche apparaît.

Cette boîte offre la possibilité d’activer des options qui peuvent en
améliorer la présentation ou rendre certaines fonctions disponi-
bles. Si vous cliquez sur Annuler, le fichier ne sera pas ouvert; si
vous cliquez sur OK, le fichier sera ouvert avec les options choisies
pour lui être appliqué.

Les trois options de la boîte principale n’affectent pas la présentation de la partition:

* Créer des parties dynamiques détermine s’il faut ou non créer un jeu par défaut de parties
dynamiques dans la partition. Si la partition possède déjà des parties (parce qu’elle a été créée
dans Sibelius 4) cette option est désactivée.

* Jouer les reprises détermine si Sibelius tient compte des barres de reprise éventuellement
présentes. Normalement cette option est désactivée car elle était activée par défaut dans les ver-
sions antérieures de Sibelius; si cependant ce réglage par défaut était désactivé, il faut le réactiver
ici pour garantir une exécution et un affichage correct des numéros de mesure dans la partition.

* Utiliser les mêmes sons que dans la version précédente (où c’est possible) permet de
choisir si Sibelius doit essayer de conserver le même son que celui utilisé pour l’exécution dans la
version précédente. Cette option ne fonctionne que si les jeux de sons utilisés avec la version
précédente sont compatibles avec Sibelius 5. Voyez Exécution de partitions existantes ci-
dessous pour en savoir plus sur l’exécution des partitions existantes.

Si vous voulez profiter dans la partition des autres nouvelles
fonctions, telles que les ligatures, les liaisons et l’espacement en
mode Optical, vous pouvez cliquez sur Style maison, ce qui
affichera la boîte de dialogue telle qu’illustrée à droite.

Toutes les options de la boîte de dialogue de Style maison
amélioreront d’une manière générale la présentation de la par-
tition. Cependant si vous les activez, il sera préférable de véri-
fier qu’aucun effet indésirable n’apparaît.

La disponibilité des options dépend de la version sous laquelle
la partition a été sauvegardée. Sibelius se rappelle des options
qui sont chaque fois choisies quand on utilise cette boîte, de
sorte que si vous savez toujours ce que voulez mettre à jour
pour travailler dans Sibelius 5, cliquez sur Tout utiliser, pour
activer toutes les options (même si certaines sont indisponibles pour la partition en cours d’ouver-
ture) et vous ne devrez plus ouvrir par la suite cette boîte de dialogue Style maison. A contrario, si
vous savez que Sibelius ne doit jamais changer la présentation de vos partitions quand vous les
ouvrez, cliquez sur Ne rien utiliser, ce qui désactive toutes les options.
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Pour en savoir plus, b 8.10 Ouvrir des fichiers de versions anciennes dans l’ouvrage de
référence de Sibelius.

Changements automatiques
Quand vous ouvrez pour la première fois dans Sibelius 5 une partition créée dans une version
antérieure, quelques changements se produisent automatiquement; plus particulièrement:

* Sibelius crée un certain nombre de styles de texte bien pratiques, s’ils n’existent pas encore (dont
Texte normal, Paroles au-dessus de la portée, Paroles (chorus), indication de mesure
(une seule portée), Reprise (D.C./D.S./à la Coda), Paroles (couplets), Code temporel,
Points de montage, Durée à la fin de la partition, Doigté de diagramme d’accord, etc.)

* Sibelius crée un certain nombre de styles de ligne dans la partition si elles n’existent pas encore
(dont toutes les lignes de rit./accel.)

* Si la partition a été créée dans Sibelius 2 ou une version antérieure, tout symbole de coda ou tout
signe de reprise est converti en symbole de système dans Sibelius 5 pour que les reprises puis-
sent s’exécuter correctement. La présentation d’une partition peut être modifiée si plus d’une
rangée d’objets de systèmes est visible dans chaque système (tel que configuré dans Style
maison > Positions des objets de système).

* Sibelius convertit les changements de type de portée, de transposition et les indications textu-
elles qui impliquent un changement de son (par ex. “prenez la flûte”) en changement d’instru-
ment – cf. ci-dessous Changements d’instrument dans les partitions existantes.

Changements d’instrument dans les partitions existantes
Le changement d’instrument est une nouvelle fonction de Sibelius qui combine les fonctions précé-
dentes de changement de type de portée et de changement de transposition. Il permet de changer
l’instrument utilisé par une portée tout au long de la partition, en changeant le son utilisé pour
l’exécution, la transposition, le type de portée ainsi que le nom de l’instrument tel qu’il doit appa-
raître sur les systèmes qui suivent le changement.

Parce que les changements de type de portée et de transposition constituaient une manière élé-
mentaire de produire les aspects individuels des changements d’instrument, il n’est plus possible de
créer un changement de type de portée ou de transposition dans les nouvelles partitions et lors de
l’ouverture d’une partition existante, Sibelius les convertit en changements d’instrument.

De plus l’ancien mécanisme qui consistait à changer le son d’exécution d’une portée en tapant dans
un style de texte de type technique le nom de l’instrument dont le son devait être utilisé a été rem-
placé dans Sibelius 5 par les changements d’instruments. Donc taper (par exemple) “Flûte” au-des-
sus de la portée ne produira plus un changement de son d’instrument lors de l’exécution, même s’il
reste possible de faire exécuter différentes techniques de jeu (telles que “sourdine” ou “pizzicato”)
en tapant l’instruction au-dessus de la portée.

Voici comment Sibelius convertit les changements de type de portée, de transposition et sons pour
l’exécution:

* Chaque changement de type de portée, de changement de transposition et de changement de
son est converti en un changement d’instrument séparé, sauf si plusieurs tombent en même
temps dans la partition, et dans ce cas ils ne forment qu’un seul changement d’instrument.
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* Sibelius traite chaque portée de gauche à droite, en accumulant les effets de chaque changement.
de sorte que si vous avez une portée de clarinette en Sib qui reçoit d’abord une transposition en
Mib, puis un changement de texte “saxophone alto”, vous obtiendrez deux changements d’instru-
ment: le premier concerne le changement de transposition et le second le changement de son,
mais ce dernier contient aussi l’instruction de changement de transposition. (Cela signifie que
vous pouvez supprimer sans danger les changements d’instruments les plus à droite après avoir
ouvert la partition dans Sibelius 5.)

* Sibelius crée une nouvelle définition d’instrument dans la partition pour chaque changement
d’instrument converti. Vous pouvez les trouver dans Style maison > Modifier les instruments,
dans l’ensemble Tous les instruments, à côté des instruments dont ils sont issus. Dans l’exem-
ple ci-dessus vous verrez deux nouveaux instruments énuméres dans la liste de la famille Vent ,
Clarinette en Sib (transp. Mib 3) et Saxophone alto (transp. Mib 3).

Après avoir ouvert la partition dans Sibelius 5, vous pouvez remplacer les changements d’instru-
ment créés par Sibelius par un changement d’instrument standard vers l’instrument souhaité. Pour
en savoir plus sur les changements d’instruments, b 2.14 Instruments dans l’ouvrage de
référence de Sibelius.

Soyez attentif au fait que Sibelius ne convertit en changement d’instrument que les changements
de portée qui sont effectivement utilisés dans la partition. Donc si vous avez défini vos propres
types de tablatures de guitare, de portées de percussion ou d’autres types de portée, vérifiez que
chacun d’eux est utilisé dans la partition avant de l’ouvrir dans Sibelius 5. Chaque type de portée
apparaîtra dans Style maison > Modifier les instruments quand vous l’éditerez par la suite.

Exécution de partitions existantes
Plusieurs améliorations substantielles ont été apportées à l’exécution dans Sibelius 5; elles sont
expliquées en détail plus loin dans ce livret. Voici cependant des situations qui pourraient
entraîner une exécution dans Sibelius 5 différente de celle produite dans Sibelius 4 et les versions
plus anciennes:

* Si vous utilisiez auparavant Kontakt Silver pour l’exécution, il n’est plus disponible dans Sibelius 5;
il a été remplacé par la nouvelle bibliothèque Sibelius Sounds Essentials, qui comporte beaucoup
plus de sons que Kontakt Silver

* Si vous utilisiez un périphérique MIDI sans jeu de sons disponible et que l’exécution fonctionnait
par réglage manuel du canal MIDI et du numéro de programme de chaque portée dans la table
de mixage, vous devez refaire ces réglages dans Sibelius 5

* Si vous utilisiez des messages MIDI pour parvenir à des effets d’exécution spécifiques, soyez
attentif au fait le résultat pourrait être différent dans Sibelius 5 (par exemple si le périphérique
d’exécution utilisé dans une version précédente n’est plus disponible), surtout si la partition est
désormais exécutée par un périphérique différent 

* Si vous avez défini vos propres types de portée de percussion à sons indéterminés dans une ver-
sion précédente, ils ne seront plus exécutés correctement dans Sibelius 5. Vous devez utiliser la
boîte de dialogue Style maison > Modifier les instruments pour mettre à jour le type de
portée de manière à obtenir une exécution correcte. b 2.21 Percussion et 7.12 Edit Instru-
ments dans l’ouvrage de référence. Lisez soigneusement dans ce livret tout ce qui concerne les
changements d’exécution dans Sibelius 5 avant de convertir toutes vos partitions existantes.
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Importer un style maison
Si vous choisissez de ne pas mettre à jour la partition en utilisant la boîte de dialogue Mise à jour
de la partition mais que par la suite vous voulez disposer des nouvelles fonctions, le moyen le
plus simple consiste à utiliser Style maison > Importer un style maison pour importer un des
styles maisons proposés.

Après importation d’un style maison dans une partition existante, de légères différences peuvent
apparaître dans l’exécution et dans l’édition d’éléments tels que les lignes et les têtes de note, parti-
culièrement si la partition provient de Sibelius 1.x. Voici ce à quoi il faut veiller:

* L’exécution de la partition peut sembler légèrement différente à cause de nouveaux mots ajoutés
dans la boîte de dialogue Exécution > Dictionnaire quand vous importez un style maison; par
exemple, des mots tels que “solo” et “sourdine” ont un effet différent dans Sibelius 5 que celui
qu’ils avaient dans Sibelius 1.x.

* Par défaut, l’exécution des notes peut être légèrement plus longue dans Sibelius 5 que dans Sibe-
lius 1.x. En général le résultat est meilleur avec un effet plus legato, mais si vous préférez l’ancien
effet vous pouvez modifier la durée des notes non liées dans la boîte de dialogue Exécution >

Interprétation.
* Il y a beaucoup plus de nouveaux types de tête de note dans Sibelius 5 que dans Sibelius 1.x, et

celles-ci s’ajoutent à la liste des têtes de note disponibles dans la partition quand on importe le
style maison par défaut; cependant, elles ne figurent pas dans l’ordre et avec le numéro tels qu’ils
sont décrits dans l’ouvrage de Sibelius de référence.

Si vous rencontrez tout comportement inattendu en travaillant des partitions existantes dans Sibe-
lius 5, consultez le Help Center en ligne à l’adresse www.sibelius.com/helpcenter pour obtenir
plus d’informations.
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Mise à jour depuis Sibelius 1.x

Si vous faites une mise à jour depuis Sibelius 1.x (c’est-à-dire depuis Sibelius 1.4 ou une version
antérieure), non seulement vous obtenez toutes les nouvelles fonctions et améliorations de Sibelius
5, mais aussi plus de 600 améliorations ajoutées dans Sibelius 2, Sibelius 3 et Sibelius 4. Il n’y a pas
assez de place dans ce livret pour les passer toutes en revue, mais vous en trouverez un résumé
dans Annexe A: améliorations apportées jusqu’à Sibelius 4.1.5 à la page 74, et tous les
détails dans l’ouvrage de référence de Sibelius.

Les changements les plus évidents concernent les menus de Sibelius, les raccourcis-clavier et la
saisie des notes. Les deux premiers types de changement sont passés en revue dans Annexe B:
changements dans les menus à la page 77 et Annexe C: raccourcis-clavier à la page 78.
Voici pour la saisie des notes:

La saisie des notes
Tandis que la saisie via Flexi-time dans Sibelius 5 est essentiellement la même depuis Sibelius 1.x, à
la fois la saisie alphabétique et celle en mode pas-à-pas ont changé significativement.

Le changement le plus évident concerne la touche Entrée du pavé qui n’est plus Modifier la note:
cela est dû au fait que désormais une distinction nette est faite entre la saisie de la note et son édi-
tion, grâce au signe d’insertion, une ligne verticale (colorée en fonction de la voix sur laquelle vous
travaillez, c’est-à-dire bleue pour la voix 1, mauve pour la voix 4) qui apparaît quand vous faites la
saisie de la musique:

* Quand le point d’insertion est visible, tout ce que vous tapez sur le pavé numérique ou que vous
sélectionnez sur le pavé à l’écran (par ex. la valeur des notes, les articulations, les altérations)
s’applique à la note qui va suivre lors de la saisie réalisée soit en tapant A–G (le nom des notes en
anglais) sur le clavier principal, ou en jouant une note ou un accord sur le clavier MIDI.

* Quand une note est sélectionnée et que le point d’insertion n’est pas visible, tout ce que vous
tapez sur le pavé numérique et sélectionnez sur le pavé à l’écran s’applique à la note en cours de
sélection, et la modifie immédiatement (c’est pourquoi le bouton Modifier la note n’est plus
nécessaire).

La touche Entrée du pavé est désormais utilisée pour ajouter des liaisons aux notes; la touche +
qui était utilisée dans Sibelius 1.x pour ajouter des liaisons aux notes est désormais utilisée pour
passer d’un pavé à l’autre.

La touche N n’est plus utilisée pour construire des accords en ajoutant une tierce au-dessus de la
note sélectionnée; il s’agit à présent du raccourci pour Notes > Saisie des notes, qui permet de
passer de la saisie (avec le point d’insertion visible) à l’édition (avec le point d’insertion invisible).
Désormais construire des accords se fait de manière beaucoup plus rapide avec les touches de
lettres et de chiffres du clavier principal:

* Les chiffres 1 à 9 du clavier principal ajoutent des notes de l’unisson à la neuvième; par exemple
taper 3 ajoute une tierce au-dessus de la note sélectionnée; taper Maj-1 à 9 ajoute les notes en
dessous, de sorte que Maj-5 ajoute une quinte sous la note sélectionnée. Vous pouvez utiliser ce
procédé sur des passages; taper 8 doublera à l’octave la ligne de basse sélectionnée.
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* Maj-A à G ajoute une note du nom spécifié au-dessus de la note sélectionnée; par exemple taper
maj-D ajoute un Ré (D en anglais) au-dessus de la note sélectionnée.

Une autre amélioration bien pratique concerne Notes > Réentrer les hauteurs de notes (rac-
courci Ctrl+Maj+I ou xXI), qui permet de changer rapidement la hauteur de notes existantes, en
passant automatiquement au-dessus des silences. On l’utilisera quand deux portées présentent des
notes de même rythme à des hauteurs différentes: faites la saisie d’une portée, copiez-la sur l’autre
portée et réentrez les hauteurs (le rythme sera conservé).

Créer des objets sans la souris
Dans Sibelius 1.x, seuls quelques objets étaient positionnés automatiquement par rapport à la note
sélectionnée quand un raccourci-clavier était utilisé, tel que liaison (avec S), soufflet, altérations,
articulations, etc.

Dans Sibelius 5 nous avons étendu ce comportement à presque tous les objets. Cela signifie que :

* vous n’avez pas à utiliser la souris pour créer des objets (même si vous pouvez encore le faire)
* vous pouvez créer pratiquement toute la musique en une seule “passe” en ajoutant les nuances

etc... aux notes concernées ce qui évite d’y revenir.

C’est facile à utiliser: avec une note ou un silence sélectionné, créez un objet à partir du menu
Insertion avec un raccourci clavier, par ex. tapez Ctrl+E ou XE pour installer du texte d’expres-
sion. Plutôt que d’attendre que vous placiez le texte avec la souris, le curseur apparaît instantané-
ment à la place intelligente qui suit la note. Tapez du texte d’expression, enfoncez Échap pour finir,
et vous pouvez continuer la saisie des notes. Tout cela sans la souris!

Le processus est exactement le même pour créer des lignes, des clefs, des symboles, des indications
de mesure, etc... Comme on travaille de gauche à droite, créer un changement de clé ou d’armure le
place après la note sélectionnée plutôt que devant et créer une indication de mesure se fait à la
mesure suivante. (Donc vous devez encore utiliser la souris pour créer une indication de mesure ou
une armure au début de la partition.)

Comme toutes les nouvelles expériences, cela peut prendre un certain temps, surtout si vos mains
vont toutes seules vers la souris (résistez à la tentation!), mais avec un peu d’habitude, vous
apprécierez l’efficacité de cette manière de travailler.

Si, cependant, vous préférez que Sibelius se comporte comme dans la version 1.x, c’est-à-dire que
tous les objets soient placés à la souris plutôt que créés automatiquement, vous pouvez restaurer ce
comportement grâce à une option présente dans les préférences:

* Choisissez Fichier > Préférences (dans le menu Sibelius sur Mac), et choisissez la page Souris
dans la liste à gauche de la boîte de dialogue

* Changez l’option Cliquer sur la souris pour le placer sous Quand vous créez un objet.

Sélectionner l’emplacement de création d’un objet
Quand on crée des objets sans utiliser la souris, il est utile de pouvoir sélectionner la note ou le
silence où l’objet doit apparaître sans la souris. Si vous n’utilisez pas beaucoup les raccourcis-clavier
pour vous mouvoir entre les notes, c’est l’occasion parfaite pour apprendre à le faire!
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Les touches de base sont 0/1 pour aller à gauche/droite des notes, et Alt+3/2 ou z3/2 pour
monter ou descendre. Maintenir enfoncé Ctrl ou X en même temps fait passer d’une mesure entière
vers la droite/gauche ou d’une portée inférieure/supérieure (plutôt que de passer d’une note à l’autre
d’un accord). Si aucun objet n’est sélectionné, taper Tab sélectionne le premier objet de la page.
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Exécution

Sibelius 5 propose un éventail complet d’améliorations pour l’exécution. Vos partitions sonnent
mieux que jamais avec Sibelius Sounds Essentials, la nouvelle bibliothèque de plus de 150 sons
prédéfinis de la plus haute qualité. Vous pouvez aussi utiliser n’importe autre quel effet ou instru-
ment virtuel au format compatible VST ou Audio Unit et contrôler l’exécution grâce à la table de
mixage au design renouvelé.

De plus, la boîte de dialogue Exécution > Dictionnaire a été complètement repensée et étendue
pour permettre un contrôle accru sur la manière dont la partition s’exécute. Enfin une nouvelle
manière révolutionnaire de description et de classement des sons appelée SoundWorld a été créée;
tout cela représente une avancée spectaculaire pour l’exécution.

Vidéos d’apprentissage
Pour obtenir une introduction générale sur le fonctionnement de l’exécution dans Sibelius, choisis-
sez Aide > Vidéos d’apprentissage, puis cliquez sur 13 Exécution.

Pour une introduction à l’utilisation de Sibelius Sounds Essentials et de Kontakt Player 2, voyez la
vidéo d’apprentissage 14 Sibelius Sounds et Kontakt Player 2.

Sibelius Sounds Essentials
Sibelius est fourni avec Sibelius Sounds Essentials, une bibliothèque de sons de haute qualité consis-
tant en un jeu complet de sons General MIDI choisis avec soin dans la bibliothèque Sibelius Sounds
Rock and Pop Collection, dans la bibliothèque primée Garritan Personal Orchestra, et dans celles de
Garritan Concert & Marching Band, Garritan Jazz and Big Band, et Virtual Drumline de chez
Tapspace. Le résultat est une collection variée de sons convenant à tous les genres de musique.

Pour en savoir plus, b 4.4 Sibelius Sounds Essentials dans l’ouvrage de référence de Sibelius.

Si vous aimez les sons de Garritan Personal Orchestra, Garritan Marching Band, Garritan Jazz and
Big Band, de Tapspace Virtual Drumline 2, et de Sibelius Rock and Pop Collection qui se trouvent
dans Sibelius Sounds Essentials, vous pouvez en acheter les versions complètes chez Sibelius ou
chez votre revendeur. Choisissez Aide > Sibelius Sounds pour en savoir plus.

Kontakt Player 2
Sibelius comporte maintenant Kontakt Player 2, une version améliorée du lecteur d’échantillons
conçue par Native Instruments, qui remplace la version précédente du lecteur Kontakt Player
présent dans Sibelius 4 et Sibelius 3. Il exécute les sons de Sibelius Sounds Essentials et de beau-
coup d’autres bibliothèques d’échantillons, dont celles de la gamme Sibelius Sounds, et celles pro-
duites par Garritan, Tapspace et d’autres concepteurs.

Kontakt Player 2 est capable d’exécuter jusqu’à 16 sons chargés simultanément et plusieurs
occurences de Kontakt Player 2 peuvent fonctionner en même temps, ce qui permet d’utiliser
autant de sons que l’ordinateur peut le supporter.

Kontakt Player 2 comporte aussi un certain nombre d’effets prédéfinis, tels que la réverbération, la
compression, l’égalisation (EQ), des filtres et des retards pouvant s’appliquer globalement sur tous
les emplacements du lecteur ce qui permet de diminuer la puissance à fournir par l’ordinateur.
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Pour en savoir plus sur la manière d’utiliser Kontakt Player 2, b 4.4 Sibelius Sounds Essen-
tials dans l’ouvrage de référence de Sibelius.

Autres produits Sibelius Sounds 
Si vous avez acheté un autre des produits Sibelius Sounds, Kontakt Gold (dont le nom est désor-
mais Sibelius Sounds Gold), Garritan Personal Orchestra Sibelius Edition, ou Sibelius Rock and
Pop Collection – téléchargez une mise à jour à gratuite pour pouvoir les utiliser avec Sibelius 5.
Pour obtenir une mise à jour, choisissez Aide > Help Center et suivez les liens jusqu’au Help Cen-
ter en ligne.

Périphériques d’exécution
Sibelius est compatible avec un large éventail de périphériques d’exécution tant logiciel que matériel: 

* du matériel MIDI externe, tels que les modules de sons et les claviers avec sons intégrés;
* du matériel MIDI interne, tels que les cartes-son à synthétiseurs intégrés;
* les instruments virtuels qui utilisent la technologie VST ou Audio Unit, et aussi Kontakt Player 2

qui est proposé avec Sibelius.
Vous pouvez utiliser ces périphériques en les combinant dans une configuration d’exécution, qui est
un ensemble de réglages de périphériques d’exécution qui détermine quels sont les périphériques
disponibles pour Sibelius et comment ils doivent être utilisés pour l’exécution. Vous pouvez régler
autant de configurations que vous le souhaitez en utilisant des périphériques différents dans cha-
cune d’elle et passez de l’une à l’autre à tout moment.

Vous pouvez créer, modifier et changer de configurations d’exécution dans la boîte de dialogue
complètement renouvelée Exécution > Périphériques d’exécution. Pour en savoir plus, b 4.11
Périphériques d’exécution dans l’ouvrage de référence de Sibelius.

Pour en savoir plus, b 4.3 Table de mixage dans l’ouvrage de référence de Sibelius.

Pour une introduction au monde des instruments virtuels et des effets, b 4.13 Instruments
virtuels pour les débutants dans l’ouvrage de référence de Sibelius.

Table de mixage
La table de mixage a été complètement redessinée dans une présentation verticale compacte avec
plusieurs fonctions. On y trouve des curseurs supplémentaires pour les instruments et effets vir-
tuels, un contrôleur de volume maître et on peut y ajuster en une fois le volume et le panoramique
de toute une famille d’instruments (par ex. les cuivres, les cordes). Et si vous possédez un clavier M-
Audio keyboard vous pouvez en utiliser les curseurs et les boutons de déplacement pour contrôler
l’exécution de Sibelius.

La table de mixage affiche cinq types de rangées, chacune représentant un type différent d’informations:
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* Chaque portée de la partition possède une rangée de
portée, qui permet de changer le volume, le panoramique,
le réglage/éteint, le son initial et le périphérique d’exécu-
tion pour cette portée

* Vous pouvez gagnez de la place verticalement en affichant
des rangées de groupe plutôt que des rangées de portées
individuelles. Les rangées de groupe permettent d’ajuster
le volume relatif et le panoramique, ou des mettre en solo
ou d’éteindre tous les instruments de la même famille (par
exemple les vents, les cuivres, les cordes), et cela d’un sim-
ple clic.

* Chaque instrument virtuel utilisé pour exécuter la partition (par exemple Kontakt Player 2, qui
est utilisé par la bibliothèque intégrée Sibelius Sounds Essentials), possède sa propre rangée
d’instrument virtuel, dont on peut afficher ou masquer la fenêtre dans laquelle s’effectuent les
réglages spécifiques à l’instrument virtuel. On peut en diriger la sortie vers n’importe quel effet
présent dans la configuration d’exécution.

* Sibelius 5 possède quatre bus d’effets, qui permettent de charger un ou plusieurs effets (dont la
réverbération, le chorus, le retard, le “flange”, etc.). Chacun des quatre bus d’effets possède sa
propre rangée de bus d’effet, dont on peut afficher ou masquer la fenêtre dans laquelle s’effectuent
les réglages spécifiques.

* Enfin, la rangée de volume maître permet d’ajuster le volume global de tous les instruments vir-
tuels utilisés dans la partition. Elle n’a cependant aucun effet sur les périphériques MIDI. Cette
rangée permet d’afficher ou de masquer les interfaces des quatre effets chargés dans le bus des
effets maîtres.

Pour en savoir plus, b 4.3 Table de mixage dans l’ouvrage de référence de Sibelius.

Des fichiers audio produits plus vite et mieux
Même si votre ordinateur ne possède pas assez de puissance pour exécuter une partition d’impor-
tance, Sibelius est capable d’en créer un fichier audio parfait, sans parasite. Et si par contre vous pos-
sédez un ordinateur rapide, Sibelius 5 créera le fichier audio plus vite que l’exécution en temps réel.

Pour en savoir plus, b 8.13 Exporter des fichiers audio dans l’ouvrage de référence de Sibelius.

Dictionnaire de l’exécution
Il est désormais possible de spécifier exactement comment les articulations, les lignes, les trémolos
et les symboles s’exécutent, par exemple pour changer la force des accents, la longueur des stacca-
tos et des pauses, la vitesse des trémolos et des accords arpégés et les expression telles que sfz et
fp. Les soufflets sont automatiquement lus en fonction de la nuance à laquelle ils aboutissent et
l’intensité des notes tenues varient tout le long du soufflet.

Sibelius 5 pourra même utiliser, si votre périphérique d’exécution le possède, un son d’échantillon
spécifique pour la trompette accentuée, les cordes en legato, les “lifts and falls”, ou les roulements.
Il indiquera au périphérique quel échantillon utiliser via des touches de contrôle, des valeurs de
contrôleurs MIDI et des couches de vélocité, et le résultat sera exportable dans les fichiers MIDI. Et



Exécution

31

Q
uo

i de neuf?

surtout, toutes ces astuces techniques se réalisent automatiquement sans intervention préalable de
votre part!

Bien que la plupart des indications standard soit prédéfinies, vous pouvez modifier exactement leur
effet sur l’exécution en utilisant la boîte de dialogue Exécution > Dictionnaire. Celui-ci possède
désormais six pages, chacune dédiée aux différents types d’effet qui peuvent affecter l’exécution:

* Le texte de portée, pour les instructions d’exécution qui s’appliquent à une seule portée, par
ex. ff, legato

* Le texte de système, pour les instructions qui s’appliquent à tous les instruments, par ex.
Fast, Swing, Adagio

* Les lignes de portée, pour les lignes qui s’appliquent à une seule portée, par ex. les trilles, les
lignes d’octava (8va), les liaisons, les soufflets

* Les Articulations, par exemple staccato, tenuto, les trémolos d’une seule note et les roulements
* Les Têtes de note, pour les effets produits par les têtes de note, par exemple les harmoniques,

ou les notes fantômes
* Les Symboles, pour d’autres instructions de type graphique tels que les scoops, les falls, les

baguettes et mailloches pour la percussion.

Pour en savoir plus, b 4.8 Dictionnaire de l’exécution dans l’ouvrage de référence de Sibelius.

Soufflets et trilles
Les soufflets déterminent désormais automatiquement la nuance à laquelle ils aboutissent, soit en
fonction du texte d’expression placé immédiatement à droite ou par augmentation ou diminution
de la nuance d’un degré (par ex. mf à f ) si aucune nuance n’est spécifiée.

Désormais, les trilles sont exécutés par défaut avec un intervalle diatonique, soit un demi-ton ou
un ton en fonction de l’armure.

Vous pouvez contrôler l’exécution des soufflets individuels et des trilles en utilisant les nouvelles
options du panneau Exécution des propriétés.

Pour en savoir plus, b 4.1 Exécution et 5.14 Propriétés dans l’ouvrage de référence de Sibelius.

SoundWorld
SoundWorld est un nouveau standard développé par Sibelius Software pour désigner et classer les
sons. Cela remplace le patchwork confus des numéros de “patch” et des noms (souvent obscurs)
utilisés par les claviers MIDI, modules de sons et bibliothèques de sons pour désigner leurs sons. À
la place, vous pouvez choisir des noms standardisés et pratiques à utiliser. Parce que les appela-
tions sont indépendantes d’un périphérique de lecture spécifique, Sibelius peut exécuter une parti-
tion qui a été créée au départ pour d’autres périphériques que ceux de votre système. Aussi, si un
son n’est pas disponible dans la configuration d’exécution en cours, Sibelius peut déterminer intel-
ligemment la meilleure alternative et l’utiliser à la place. Vous pouvez aussi exécuter des techniques
instrumentales (tels que les liaisons et les accents) en utilisant des sons spécialisés s’ils sont dis-
ponibles, plutôt que de le faire approximativement en changeant la durée ou le volume.

SoundWorld utilise pour chaque son un nom structuré appelé son ID, tels que wood-
wind.flutes.flute, woodwind.flutes.piccolo.flutter-tongue ou strings.violin.ensemble.pizzicato.
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Notez que chaque son ID commence en général avec une famille d’instrument, puis le nom de
l’instrument, parfois suivi par une technique de jeu spécifique à l’instrument.

Les sons ID apparaissent dans Sibelius chaque fois que sont spécifiés des sons. Par exemple:

* Chaque instrument possède son ID de préférence, qui peut être modifié dans Style maisons >

Modifier les Instruments

* La table de mixage affiche le son ID de chaque portée de la partition
* Chaque tête de note d’une portée de percussion possède son propre son ID de préférence, qui

peut être changé en modifiant l’instrument
* Toutes les techniques de jeux et les articulations des instruments sont décrites par les sons ID, et

peuvent être modifiées dans Exécution > Dictionnaire.

Le terme SoundWorld désigne simplement une collection de sons ID, organisés en une structure
arborescente. Le SoundWorld spécifique utilisé par Sibelius s’appelle Sibelius Standard Sound-
World (ou S3W en abrégé), qui est une liste intelligente de sons disponibles dans les bibliothèques
et périphériques MIDI les plus communs. Dès que plusieurs sons disponibles, ils sont ajoutés au
S3W.

Pour en savoir plus, b 4.16 SoundWorld dans l’ouvrage de référence de Sibelius.

Si, cependant vous préférez voir les noms de programme de votre instrument d’exécution plutôt
que les sons ID dans la table de mixage et la boîte de dialogue Style maison > Modifier les instru-
ments, choisissez Fichier > Préférences (dans le menu Sibelius sur Mac), allez à la page Exécu-
tion et réglez l’option Affichage au sommet droit de la fenêtre Noms de programme.

Pour en savoir plus, b 4.3 Table de mixage dans l’ouvrage de référence de Sibelius.

Autres améliorations pour l’exécution
* Le bouton Jouer en arrière fond a été supprimé de la nouvelle boîte de dialogue Exécution >

Périphériques d’exécution car quand il fonctionne Sibelius sollicite désormais tous les péri-
phériques MIDI et audio.

* La ligne de lecture se déplace désormais note par note ou temps par temps selon ce qui se
présente en premier.

* Exécution > Périphériques de substitution a été supprimé, car cela n’avait plus de raison d’être.
* Exécution > Garritan Personal Orchestra Options a été supprimé, car cela n’avait plus de rai-

son d’être.
* Sibelius exécute désormais correctement les notes liées qui se présentent juste avant une barre de

mesure de reprise.

Dossier instruments virtuels et effets (Windows uniquement)
Pour pouvoir utiliser les instruments VST et les effets, Sibelius ne se réfère qu’à un seul dossier au
nom spécifique. Si votre ordinateur contient déjà des instruments VST ou des effets, vous devriez
les copier dans le dossier spécifique par défaut de Sibelius à savoir C:\Program Files\Sibelius
Software\VSTPlugins.

Vous pouvez changer de dossier en choisissant Exécution > Périphériques d’exécution, puis en
cliquant Options du moteur audio.
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Idées

b 5.8 Idées dans Sibelius Référence.

Souvent quand les compositeurs sont au travail, des morceaux de mélodie, de rythme, d’accompa-
gnement ou des progressions d’accords qui paraissent intéressants leur viennent à l’esprit. Quant
aux arrangeurs et aux copistes, ils ont souvent à utiliser et à réutiliser des fragments de notation,
tels que des indications de texte, des symboles ou des diagrammes d’accord spécifiques, etc...

Nous appelons tous ces fragments des idées: peu importe leur longueur, leur nature et le nombre
d’instruments concernés. Il suffit de frapper une touche pour capturer une idée et la mémoriser pour
une utilisation ultérieure. Vous pouvez éditer n’importe quelle idée capturée, la décrire avec vos pro-
pres mots-clé (par ex. canon, lyrique, riff) pour en faciliter la recherche et en plus la mettre en
couleur selon des codes. La fenêtre des idées permet de naviguer et de rechercher parmi l’ensemble
des idées disponibles, et toutes peuvent être écoutées. Utiliser une idée est aussi simple que de coller
à partir du presse-papiers; et Sibelius gère même la transposition selon la tonalité et la tessiture.

Vous pouvez importer et exporter des ensembles d’idées pour les partager avec d’autres personnes,
même par Internet. Et pour les professeurs ou les éducateurs, il est possible de sauvegarder des
ensembles d’idées dans une partition pour créer des exercices de composition destinés aux étudiants.

De plus, Sibelius propose plus de 2000 idées préfabriquées, pour une multitude d’instruments et de
genres différents, de sorte qu’il suffit de quelques secondes pour trouver ce qui convient en cas de panne
d’inspiration ou de recherche d’un élément stylistique précis pour lancer un processus de création.

Vidéo d’apprentissage
Pour une introduction aux idées, choisissez Aide > Vidéos d’apprentissage, et cliquez sur 07 Idées.

Qu’est-ce qu’une idée
Une idée, c’est pratiquement tout ce qu’il est possible d’écrire dans Sibelius. Quelque soit l’impor-
tance du matériau - de la simple note sur une portée à des centaines de mesures sur un nombre
illimité de portées - vous pouvez le sélectionner et le capturer en tant qu’idée. La nature des objets
elle aussi, peut être variée: lignes, symboles, objets textuels et même images importées peuvent
être capturées comme idées, qu’il y ait ou non des notes.

Outre la musique qu’elle contient, une idée est toujours associée à des mots-clé. Ceux-ci servent à la
décrire et à permettre de la retrouver facilement par la suite. Quand il s’agit d’examiner plusieurs
milliers d’idées, c’est vraiment pratique! Pour chaque idée, en plus des mots-clé que vous avez
spécifiés, Sibelius en ajoute d’autres tels que la tonalité et l’indication de mesure, le tempo, etc...
Vous pouvez rechercher des idées en utilisant n’importe quels mots-clé choisis soit parmi les
vôtres, soit parmi ceux créés automatiquement par Sibelius. Vous pouvez aussi attribuer une
couleur spécifique à n’importe quelle idée
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La fenêtre des idées
D’une manière générale, le travail sur les idées s’effectue dans la fenêtre des idées, que l’on
affiche ou masque avec la commande Fenêtre > Idées (raccourci Ctrl+Alt+I ou zXI), ou en
cliquant sur le bouton de la barre d’outils illustré ci-contre à droite.

La fenêtre des idées peut s’afficher sous deux formes différentes, compacte et détaillée. Par défaut, elle 
s’ouvre en affichage compact, qui a l’aspect suivant

Essayez les boutons Bibliothèque, Partition et Toutes. Quand le bouton Bibliothèque est activé,
vous pouvez accéder à environ 2000 idées prédéfinies. Utilisez l’ascenseur pour dérouler la liste.

Chaque idée de la liste propose en prévisualisation la musique et les autres objets qu’elle contient;
normalement on doit voir deux ou trois mesures de la portée supérieure (les idées peuvent cepen-
dant contenir un nombre quelconque de mesures ou d’instruments). Des mots-clé importants sont
affichés aux quatre coins de la prévisualisation; dans le coin supérieur gauche le nom de l’idée,
dans le coin supérieur droit la lettre L apparaît si l’idée est contenue dans la bibliothèque plutôt que
dans la partition en cours; dans le coin inférieur gauche, l’indication de mesure de l’idée; dans le
coin inférieur droit, son tempo.

Cliquez sur la flèche au sommet de la fenêtre pour afficher une liste des mots-clé les plus courants.
Choisissez-en un dans la liste, et la liste du dessous affichera seulement les idées qui correspondent
au mot-clé entré. Cliquez de nouveau sur la flèche pour afficher une liste des mots-clé les plus
fréquemment utilisés dans les idées qui utilisent le mot-clé déjà choisi. De cette manière, il est très
rapide d’établir une liste d’idées correspondant le mieux possible à ce qui est recherché.

Entrer les mots-clé ici...

...ensuite choisir d’afficher les
idées soit de la partition en

cours, soit celles de la Biblio-
thèque ou Toutes Un cadre indique l’idée sélectionnée; 

pour changer d’idée sélectionnée, 
utilisez 2/3 

Copier

Coller

Éditer

Éditer la fenêtre 

Supprimer

Ajouter des idées à la partition

Ajouter à la bibliothèque

Passer à l’affichage 
détaillé

...ou cliquer sur cette flèche pour 
dérouler la liste...

Capturer l’idée
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Écouter une idée
Pour entendre à quoi ressemble une idée, il suffit de cliquer dessus dans la fenêtre des idées et de
maintenir le bouton gauche de la souris enfoncé pour lancer la lecture; Sibelius va jouer l’idée en
boucle en la répétant jusqu’à ce que la souris soit relâchée.

Capturer une idée

Pour créer une idée, sélectionnez quelque chose dans la partition et choisissez Éditer > Capturer une 
idée (raccourci Maj-I). Vous pouvez capturer une idée à partir de tout type de sélection, à savoir:

* Une sélection de passage d’un nombre quelconque de mesures ou de portées
* Un seul objet sélectionné, par ex. une note, un objet texte, une ligne, etc...
* Des sélections multiples de notes, par exemple les premier et troisième temps d’une mesure,

sélectionnés par Ctrl+clic ou X-click, ou au moyen d’un filtre
* Des sélections multiples d’éléments autres que des notes, par exemple une série de texte

d’expression et de soufflets, sélectionnés par Ctrl+clic ou X-clic, ou au moyen d’un filtre.

Rechercher une idée
Pour rechercher une idée, entrez un ou plusieurs mots-clé dans la boîte au sommet de la fenêtre
des idées, puis choisissez une idée dans la liste.

Au fur et à mesure que l’on entre des mots dans la boîte, Sibelius déroule en dessous un menu qui
contient les mots-clé correspondant à ce qui est entré (par ex. si vous tapez “cl” , “clarinette”,
“closed”, “classique”, pourront s’afficher mais en ajoutant “a”, “closed” disparaîtra de la liste). On peut
soit continuer à taper, ou utiliser les touches de flèche ou la souris pour sélectionner un des mots-
clé de la liste. Aussitôt qu’on a choisi un mot-clé ou que l’on a tapé espace pour indiquer que le mot-
clé est entièrement entré, la liste des idées de la partie principale de la fenêtre est mise à jour.

Vous pouvez aussi entrer une autre donnée. Dès qu’une seconde donnée est ajoutée, seules les idées
qui correspondent à la fois à la donnée originale et à la nouvelle donnée seront affichées dans la
liste. Comme précédemment, quand vous commencez à taper dans la boîte, le menu se déroule
pour vous montrer les mots-clé possibles qui correspondent aux lettres déjà tapées.

Au fur et à mesure que vous ajoutez un autre mot-clé dans la boîte, le choix des idées dans la partie
principale de la fenêtre va se réduire, car plus il y a de mots-clé, moins d’idées leur correspondent.
Pour sélectionner une idée dans la liste, cliquez dessus.

Les idées se présentent dans la liste de la partie principale de la fenêtre des idées par ordre décrois-
sant de pertinence. Si le mot-clé que vous avez tapé est le Nom de l’idée alors c’est un critère haute-
ment pertinent; si le mot-clé apparaît dans la liste générale des Mots-clé, alors il est considéré
comme assez pertinent, si le mot-clé est généré par Sibelius, il est considéré comme peu pertinent.

Coller une idée
Avant de coller une idée, il faut la copier dans le presse-papiers. Pour cela, il suffit de sélectionner
la fenêtre des idées, puis de taper Ctrl+C ou XC, ou de cliquer sur le bouton Copier qui figure
dans le bas de la fenêtre, ou de faire un clic-droit (Windows) ou Contrôle-clic (Mac) et choisir
Copier dans le menu contextuel.
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Coller une idée dans une partition est exactement pareil à toute forme de collage: soit vous sélec-
tionnez l’emplacement dans la partition où doit figurer l’idée et vous choisissez Édition > Coller
(raccourci Ctrl+V ou XV); soit si rien n’est sélectionné, choisissez Édition > Coller puis cliquez à
l’emplacement dans la partition où doit figurer l’idée. On peut aussi cliquer sur le bouton Coller
qui figure dans le bas de la fenêtre des idées.

Comme avec toute forme de collage, il est possible de coller une idée en plusieurs exemplaires soit
en utilisant la copie multiple, soit avec la commande Édition > Répéter (raccourci R) utilisée
immédiatement après collage pour répéter l’idée de manière consécutive.

Contrairement à un collage normal, lors d’un collage d’idée, Sibelius réalise automatiquement
quelques opérations supplémentaires: il transpose l’idée pour qu’elle corresponde à la tonalité qui
prévaut à l’emplacement de la partition où a lieu le collage, et il transpose aussi les octaves de
manière à ce que les notes correspondent à la tessiture de l’instrument dans lequel est collée l’idée.

Idées prédéfinies
Sibelius propose plus de 2000 idées, conçues pour stimuler l’inspiration des compositeurs de tous
les âges et qui recouvrent un éventail de genres le plus large possible dès le niveau élémentaire.

Chaque idée a un nom, en principe un nom de genre, suivi de l’instrument utilisé (ou de plusieurs
selon le cas) et terminé par un numéro. En général plus le nombre est élevé, plus la musique de
l’idée est complexe. Les idées prédéfinies sont aussi colorées selon leur genre (comme affiché dans
la liste ci-dessous). 

Pour rechercher une idée d’un genre spécifique, entrez d’abord l’un des mots-clé suivants:

Vous pouvez affiner les recherches en utilisant des mots-clé comme ceux-ci:

* Instrument, par ex. guitare, percussion, piano
* Tempo, par ex. rapide, lent, moderato
* Type d’idée, par ex. mélodie, accompagnement, rythme
* Complexité, par ex. élémentaire, modéré, complexe
* Humeur, par ex. joyeux, triste, pensif
* Qualification, par ex. excité, vivant, relax, majestueux, majeur, mineur, swing, dramatique,

humoristique

* Africain (pêche)
* Chill Out (vert pastel)
* Classique (vert citron)
* Concert Band (vert vif)
* Country (jaune)
* Dance (gris)
* Film (bleu ciel)
* Folk (olive)
* Funk (gris-rose)
* Gamelan (bourgogne clair)
* Garage (bleu voilé)

* Groovy (rose pastel)
* Hip Hop (bleu pastel)
* Jazz (rose intermédiaire)
* Latin (orange)
* Marching Band (turquoise)
* Classique moderne (vert foncé)
* Motown (beige)
* Pop (bleu vif)
* Reggae (violet)
* Rock (rose vif)
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Tapez un ou plusieurs mots-clé de ces catégories et vous trouverez des idées qui correspondent à
vos recherches.

Voici quelques astuces supplémentaires pour utiliser des idées prédéfinies dans vos partitions:

* Les idées peuvent être de longueur différente, en général entre deux et huit mesures. Les idées
peuvent convenir par exemple pour illustrer des points spécifiques de composition, de style ou
technique de jeu, tandis que les idées les plus courtes conviendront mieux pour s’intégrer dans
vos compositions en les traitant de diverses manières telles qu’une transformation, une répéti-
tion ou autre chose.

* Pratiquement toutes les idées sont pour instrument seul (comme leur nom le spécifie), et fonc-
tionnent mieux si elles sont collées dans l’instrument pour lequel elles ont été conçues, ou sinon
un instrument très proche. Cependant vous pouvez coller une idée sur une portée dans votre
partition et Sibelius la transposera en fonction de la tessiture de l’instrument; donc ne vous
privez de le faire.

* Toutes les idées d’un genre ont été conçues pour fonctionner ensemble, même si elles ne par-
tagent pas nécessairement les mêmes structures harmoniques et séquences d’accord. Les idées
avec instrument de même numéro tels que Reggae Bass 1 et Reggae Keyboard 1, en général
fonctionnent bien ensemble.

* Les idées prédéfinies ont été conçues pour sonner le mieux possible avec Sibelius Sounds Essen-
tials et l’option Exécution > Exécution enregistrée activée, mais naturellement vous pouvez les
jouer sur n’importe quel périphérique..

Éditer une idée
Vous pouvez éditez à la fois la musique et les mots-clé des idées. Pour éditer les mots-clés d’une
idée, sélectionnez-la dans la fenêtre des idées, puis cliquez sur le bouton Modifiez l’information
de l’idée dans le bas de la fenêtre, ou faites un clic-droit et choisissez Modifiez l’information de
l’idée dans le menu contextuel.

Pour éditer la musique d’une idée, sélectionnez-la dans la fenêtre des Idées, puis cliquez sur le bou-
ton Modifier une idée en bas de la fenêtre, ou faites un clic-droit et choisissez Modifier une idée
dans le menu contextuel.

Une nouvelle fenêtre va apparaître, comme si une autre partition était ouverte et peut s’éditer
comme n’importe quelle autre partition

Quand vous avez terminé d’éditer votre idée, sauvegardez-la avec la commande Fichier > Sauve-
garder (raccourci Ctrl+S ou XS), puis fermez la fenêtre avec la commande Fichier > Fermer (rac-
courci Ctrl+W ou XW) pour revenir à la partition originale.

Si vous décidez de ne pas sauvegarder les changements réalisés, il suffit de choisir Fichier >
Fermer, puis de cliquer sur Non quand il vous est demandé si vous voulez sauvegarder les change-
ments réalisés.

Où les idées sont-elles sauvegardées?
Une idée peut être sauvegardée soit dans la partition en cours, soit dans la bibliothèque. Quand
une idée est sauvegardée dans une partition, elle peut seulement apparaître dans la fenêtre des
idées quand la partition est ouverte et quand le bouton Partition est activé. Quand une idée est
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sauvegardée dans la bibliothèque, elle peut apparaître dans la fenêtre des idées quelle que soit la
partition ouverte, pourvu que le bouton Bibliothèque soit activé.

Par défaut quand vous capturez une idée, elle s’ajoute à la partition en cours, ce qui signifie qu’elle
est seulement disponible pour cette partition, à moins de la sélectionner et de cliquer sur Ajouter
à la bibliothèque dans la fenêtre des idées. Si vous préférez que les idées soit directement
envoyées dans la bibliothèque, activez Ajouter les nouvelles idées dans: la bibliothèque à la
page Fichier > Préférences (dans le menu Sibelius sur Mac).

Partager des idées
Si vous souhaitez partager vos idées avec d’autres personnes, voici deux manières de procéder: soit
vous sauvegardez les idées à partager dans une partition spécifique et ensuite vous distribuez cette
partition (ce qui est pratique pour la mise au point de projets avec des étudiants); soit vous
exportez une sélection d’idées sous forme de fichier .ideas que quelqu’un d’autre pourra importer
dans sa bibliothèque.

Importer des idées
Pour importer des idées dans votre bibliothèque, par exemple si vous avez reçu un fichier .ideas
d’un autre utilisateur de Sibelius, activez l’affichage détaillé de la fenêtre des idées, puis cliquez sur
Importer. Vous serez invité à choisir le fichier .ideas à importer; cliquez sur Ouvrir et une boîte de
dialogue apparaît, vous proposant de spécifier si les idées importées doivent être ajoutées à la bibli-
othèque ou à l’une des partitions ouvertes.
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Panorama

b 5.10 Panorama dans l’ouvrage de référence de Sibelius.

Panorama est une manière différente (parfois appelée mode défilement dans certains programmes)
d’afficher la partition. Au lieu de figurer à l’écran page par page comme elle sera imprimée, la par-
tition se déroule en continu sur un seul système comme sur un rouleau de papier.

Avec Panorama, vous vous concentrez sur la saisie et l’édition sans tenir compte de la mise en page. La
saisie est très pratique, surtout pour les partitions de plusieurs systèmes par page; Panorama élimine
les mouvements verticaux de système à système car la partition se déplace seulement de manière
horizontale. On évite ainsi la sensation d’être un peu perdu qui se produit parfois en affichage normal.

Vidéo d’apprentissage
Pour une introduction à Panorama, choisissez Aide > Vidéos d’apprentissage, puis cliquez sur
09 Panorama, Portées en vue ciblée et Propriétés 

Activation de Panorama
Pour activer Panorama, il suffit de choisir Affichage > Panorama (raccourci Maj-P), ou de
cliquer sur le bouton de la barre d’outils tel qu’illustré à droite. L’activation a pour effet:

* Désactivation du navigateur, puisqu’il n’y a plus qu’une page
* Activation de Affichage > Barres de défilement

* Activation de Affichage > Noms des portées et numéros de mesures.

Pour désactiver Panorama, il suffit de choisir de nouveau Affichage > Panorama.

Si, lors d’une session en Panorama, vous désactivez les Barres de défilement ou les Noms des
portées et numéros de mesures, ces réglages sont conservés tant que Panorama reste actif, mais
aussi lors de son utilisation ultérieure.

Se déplacer dans Panorama
On travaille dans Panorama quasi comme en affichage normal; tous les raccourcis habituels de
navigation (par ex. Début, Fin, Vers le haut ou 8, Vers le bas ou 9, etc.) ainsi que les fonctions
comme le zoom fonctionnent normalement. Le niveau de zoom Ajuster selon la hauteur de la
page est particulièrement utile car il permet de voir toutes les portées en même temps.

Vous remarquerez que si vous déplacez le début de la partition vers la gauche de l’écran, la clé et
l’armure de chaque portée s’affichent en bleu en guise d’aide-mémoire.

Saisie et édition dans Panorama
Que ce soit dans Panorama ou en affichage normal, la saisie et l’édition se réalisent de manière pra-
tiquement identique. Seules quelques opérations sont impossibles dans Panorama car elles
n’auraient aucun sens puisqu’il n’y a pas de page:

* Il est impossible dans Panorama de voir ou d’introduire du texte aligné sur la page (tels que
Titre, En-tête (après la première page), etc.) 
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* Si Affichage > Marques de mise en page est activé, Sibelius affiche les marques de mise en
page au-dessus des barres de mesure, mais les sauts de système ou de page existants ou nou-
veaux qui seraient créés resteront sans effet

* Il est impossible d’imprimer dans Panorama (vu le peu d’imprimantes capables d’imprimer sur
rouleau infini!); de sorte que si vous choisissez Fichier > Imprimer, la partition sera imprimée
telle qu’elle se présente en affichage normal

* Mise en page > Masquer les portées vides ne peut s’utiliser puisqu’il faut plusieurs systèmes
pour l’appliquer alors qu’il n’en existe qu’un en Panorama; par conséquent toutes les portées
masquées en affichage normal apparaissent dans Panorama

* Édition > Allez à la page et insertion > Autres > Changement de numéros de page est désactivé
* Mise en page > Aligner les portées est désactivé
* Quand vous choisissez Fichier > Exporter > Images, seule une Sélection d’images peut

s’exporter et non des systèmes ou des pages spécifiques.

Espacement des notes dans Panorama
Dans Panorama, Sibelius utilise un espacement de notes “non justifié”; en d’autres mots, il va rap-
procher ou éloigner les notes de manière à remplir les pages. Remarquez, que, si vous réalisez dans
Panorama des ajustements dans l’espacement des notes, tel qu’agrandir une mesure (par ex. pour
éviter des collisions entre symboles d’accords), ces changements seront réalisés et affichés dans
Panorama comme en affichage normal.

Cependant, prenez garde au fait que si l’ajustement est réalisé dans Panorama, donc sans prise en
compte de la largeur de la page, le résultat dans l’affichage normal sera différent, plus étendu ou
plus serré en fonction de la largeur de page, cette fois prise en compte.

Espacement des portées dans Panorama
Dans Panorama, Sibelius utilise l’espace entre les systèmes définis dans les pages Portées du menu
Style maison > Règles de gravure multiplié par un facteur fixe de justification spécifié dans
Fichiers de Fichier > Préférences (dans le menu Sibelius sur Mac). Puisqu’il n’y a pas de hauteur
de page déterminée, Sibelius ignore la valeur de Justifier les portées quand la page et remplie
à au moins x%, si bien que parfois les portées paraissent plus proches qu’en affichage normal.

Cependant de manière fort pratique, il est possible dans Panorama d’ajuster l’espacement entre les
portées sans affecter l’affichage normal; par ce procédé on évitera les collisions entre notes et
objets de portées différentes; pour réaliser cela, il suffit de déplacer les portées comme d’habitude. 

Utilisation de Panorama en combinaison avec Portées en vue ciblée
Quand Affichage > Portées en vue ciblée est utilisé avec deux portées ou un peu plus, l’affichage
normal peut sembler parfois bizarre en raison de l’absence des autres portées; mais si vous activez
en même temps Affichage > Panorama, Portées en vue ciblée devient vraiment pratique. 

Ouverture de partitions dans Panorama
Quand vous sauvegardez une partition, Sibelius mémorise l’état de Panorama, ce qui garantit que
s’il était actif à la sauvegarde, il le sera à l’ouverture ultérieure de la partition. Il est même possible
pour tout lancement de Sibelius de choisir entre Panorama et affichage normal et cela dans la page
Fichiers de Fichier > Préférences (dans le menu Sibelius sur Mac) .
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Répliques

b 2.24 Répliques dans l’ouvrage de référence de Sibelius.

Créer des répliques dans les parties est maintenant la tâche à accomplir. Il suffit de copier les notes
qui doivent apparaître dans la réplique et de choisir Édition > Coller en tant que réplique. Sibe-
lius 5 s’occupe du reste, comme expliqué ci-dessous.

Coller en tant que réplique
Avec la nouvelle fonction de Sibelius 5, activée par Édition > Coller en tant que réplique, créer
une réplique ne prend qu’un instant::

* Assurez-vous que vous êtes dans le conducteur et non dans une des parties dynamiques. Bien
qu’il soit possible d’utiliser Édition > Coller en tant que réplique dans une partie dynamique, il
est plus pratique de le faire dans le conducteur, de manière à visualiser la portée qui servira de
base à la réplique et de la coller sur plusieurs instruments en même temps

* Copier la musique souhaitée comme réplique dans le presse-papiers en la sélectionnant, puis
choisissez Édition > Copie (raccourci Ctrl+C ou XC)

* Sélectionnez la pause de mesure ou le silence de la (des) portée(s) qui doit(vent) recevoir la
réplique et choisissez Édition > Coller en tant que réplique (raccourci Ctrl+maj+Alt+V ou
xzXV). Si vous sélectionnez plus d’une portée, Sibelius collera la réplique sur toutes les
portées sélectionnées grâce au processus de copie multiple.

C’est tout! Voici tout ce qui se produit automatiquement lorsqu’un passage en réplique est collé:

* La musique copiée apparaît dans la première voix inutilisée; toutes les notes et autres indications
sont à taille de note de réplique

* La réplique est masquée dans le conducteur mais affichée dans les parties séparées (bien qu’il
soit possible de l’afficher dans le conducteur)

* Toutes les transpositions difficiles (par ex. une réplique de clarinette en La sur une portée de cor
en Fa) sont réalisées et si nécessaire, une clef adéquate ou un octava est ajouté pour permettre
une lecture aisée selon vos préférences

* Le nom de l’instrument jouant la réplique est écrit au-dessus de la réplique
* Si le type de portée (par ex. le nombre de lignes) de l’instrument jouant la réplique ne corres-

pond pas à celui de l’instrument de destination, les changements d’instrument appropriés sont
créés au début et à la fin de la réplique

* Les indications spécifiques (telles que les paroles, les nuances, les liaisons de phrasé et les souf-
flets) sont automatiquement incluses ou exclues, selon vos préférences

* Les notes de réplique sont réglées de manière à ne pas être exécutées
* Les pauses de mesure sont ajoutées dans une voix inutilisée à la fois dans le conducteur et les

parties, de manière correcte (mais si vous le préférez, vous pouvez spécifier de ne pas ajouter des
pauses de mesure dans les parties).
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En fait la seule chose que Sibelius ne fera pas, c’est de décider quel instrument doit être utilisé
comme réplique; mais il peut suggérer des emplacements, comme expliqué maintenant:

L’extension proposer des répliques
Quand on prépare des parties pour une exécution, une des choses qui prend le plus de temps, c’est
de déterminer l’emplacement des répliques les plus utiles. Vous pouvez ajouter des répliques après
un certain nombre de pauses de mesure, ou après un certain temps. C’est la tâche réalisée par
Extensions > Divers > Proposer des emplacements de réplique

L’extension vérifier les répliques
Tout changement réalisé dans la partition après avoir installé les répliques est une source poten-
tielle d’erreurs dans ces répliques car Sibelius n’établit pas de lien automatique entre le passage
d’origine de la réplique et celui de sa destination. Cependant, une extension pratique est proposée,
qui permet de vérifier les répliques par rapport à leur portée d’origine et indique toute omission; il
suffit de sélectionner le passage en question et de choisir Extensions  > Corrections d’épreuves >

Vérifier les répliques

Préférences de coller une réplique
Ce qui se produit quand on utilise Édition > Coller en tant que réplique dépend de différentes
options déterminées à la page Coller en tant que réplique de Fichier > Préférences (dans le
menu Sibelius sur Mac), et décrites ci-dessous.

Les options Hauteur des répliques proposent trois manières différentes de résoudre les dif-
férences de tessiture entre les portées d’origine et de destination:

* Changer la clé si nécessaire ajoute une clé au début de la réplique collée, si les clés utilisées
par les portées d’origine et de destination ne correspondent pas. Si vous collez une réplique, par
ex. une portée de cello sur une portée de flûte, Sibelius va créer une clé de fa au début de la répli-
que et rétablira une clé de sol à la fin. Notez que ces changements de clés ne sont visibles que
dans les parties.

* Ajout d’octava si nécessaire ajoute une ligne d’octava (jusqu’à deux octaves au-dessus ou en
dessous, c’est-à-dire 8va, 15ma, 8vb ou 15mb) sur la réplique collée si Sibelius doit transposer la
réplique d’une ou plusieurs octaves pour garantir un placement confortable sur la portée.

* Sons entendus collera simplement la réplique dans la portée de destination en respectant la clé
et sans changer d’octaves.

Les options de Copier dans la réplique permettent de déterminer si Sibelius va incorporer dans
la réplique collée les Liaisons de phrasé, les Articulations, les Nuances, les Paroles et le Texte
technique .

Par convention, on ajoute dans les répliques des pauses de mesure pour indiquer clairement à
l’interprète qu’il s’agit bien de notes à ne pas jouer figurant à titre informatif. Cependant, dans cer-
tains styles de musique, tels que le jazz, en général on n’ajoute pas de pauses de mesure. Inclure les
pauses de mesure (dans les parties) permet de choisir la convention à suivre: activée (par
défaut), les pauses de mesure d’origine de la partie sont affichées en plus des notes de réplique;
désactivée, seules les notes de réplique apparaissent.



Répliques

43

Q
uo

i de neuf?

De nouveau, dans certains styles de musique, le jazz principalement, le mot “Jouez” figure après la
réplique, pour rappeler à l’interprète que c’est le moment de recommencer à jouer. Ajouter l'indi-
cation 'Jouez' après les répliques dans les parties, est l’option, désactivée par défaut, qui réa-
lise cela. Elle est surtout utile si l’option Inclure les mesures de silence (dans les parties) est
désactivée.

Dans la plupart des styles de musique, la convention consiste à n’afficher les répliques que dans les
parties, de sorte que Masquer les répliques dans le conducteur est activé par défaut. Cependant,
dans certains cas spécifiques, par exemple la musique de scène, on affiche les répliques dans le con-
ducteur; donc pouvoir désactiver cette option peut parfois s’avérer utile dans certaines situations.

Soyez attentif au fait que changer les options ici n’affectent pas les répliques déjà collées; seules
seront affectées les répliques créées par la suite avec Édition > Coller en tant que réplique.

Masquer les portées vides
Une portée peut être masquée via Mise en page > Masquer les portées vides pourvu que tous
les objets qu’elle contient soit réglés pour être masqués dans l’affichage en cours. Cela signifie
qu’une portée peut être masquée dans tout conducteur si elle contient un passage de réplique mas-
qué réglé pour n’apparaître que dans une partie dynamique.

Le fait de taper sur Suppr ne masque jamais les portées vides; pour le faire il faut explicitement
choisir Mise en page > Masquer les portées vides.
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Instruments

Dans les partitions, il arrive souvent que deux ou plusieurs instruments soient joués par la même
personne, par exemple un percussioniste jouant de plusieurs instruments, ou un clarinettiste pas-
sant au saxophone. Or auparavant, il fallait parfois réécrire une partie complète pour chaque
instrument. Désormais Sibelius réalise automatiquement cette opération: il suffit de créer un
changement d’instrument n’importe où dans la partition et Sibelius 5 changera l’instrument à
l’endroit choisi, en modifiant le nom, la clé, le son et même la transposition et le type de portée si
nécessaire.

De plus, si vous écrivez pour des instruments inhabituels, vous pouvez concevoir le vôtre en
choisissant le nom, la tessiture, les sons, etc... selon votre bon vouloir. Du glockenrimba à la trom-
pette en Fa#, la seule limite est votre imagination!

Changement d’instrument
Sibelius permet de changer facilement d’instruments n’importe où sur la portée en utilisant
Insertion > Autre > Changement d’instrument. La boîte de dialogue suivante apparaît:

* Choisissez dans la liste l’instrument qui sera installé par le changement. Les deux options sui-
vantes peuvent être ajoutées:
% Si Ajouter la clef (si nécessaire) est activé, Sibelius créera un changement de clé à l’endroit

où le changement de clé apparaît, si la clé du nouvel instrument est différente de l’instrument
original

% Si Annoncer à la dernière note de l'instrument précédent est activé, Sibelius créera un
avertissement , “prendre [instrument]”, au début des silences qui précèdent le changement.

* Maintenant, cliquez sur OK. Si vous n’avez pas fait de sélection avant d’avoir ouvert la boîte de
dialogue, votre pointeur de souris devient bleu, et vous pouvez cliquer sur la partition pour
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placer le changement d’instrument; sinon Sibelius crée automatiquement le(s) changement(s) à
l’endroit de la sélection.

Voici ce que Sibelius réalise automatiquement lors de la création d’un changement d’instrument:

* Il change le son de la portée de manière appropriée pour l’exécution
* Il change le nom de l’instrument sur les systèmes qui suivent (ce que vous pouvez modifier si

vous le souhaitez). Si vous ne souhaitez pas que le nom de l’instrument change, choisissez Style
maison > Règles de gravure (raccourci Ctrl+Maj+E ou xXE), puis dans la page Instruments,
activez Ne pas changer les noms d’instruments au début des systèmes qui suivent les
changements d’instrument

* Il écrit le nom du nouvel instrument au-dessus de la portée, là où il commence à jouer (ce que
vous pouvez modifier si vous le souhaitez)

* Il change la transposition de la portée, si nécessaire (par exemple pour passer d’une clarinette en
Sib à une clarinette en La), affichant un changement d’armure si Notes > Partition transposée
est activé

* Il change le type de portée, si nécessaire (par ex. il modifie le nombre de lignes de portée, installe
une tablature ou une portée normale, etc.).

Les exemples ci-dessous illustrent comment les changements d’instruments apparaissent dans une
partition, dans le cas d’un changement d’une clarinette en Sib en saxophone alto (en Mib). À
gauche, Affichage > Objets masqués est activé (de sorte que vous pouvez voir exactement le
changement sous forme de rectangle gris), et Notes > Partition transposée est désactivé (les
notes sont donc à hauteur réelle); à droite, Notes > Partition transposée est désactivé.

Puisque les changements d’instruments réalisent en même temps les changements de transposi-
tion et les changements de portée, ces deux opérations ne sont plus possibles séparément dans
Sibelius 5, de sorte qu’à la fois Insertion > Autre > Changement de transposition et Insertion >

Autre > Changement de type de portée ont été supprimés.

Pour en savoir plus, b 2.12 Instruments dans l’ouvrage de référence de Sibelius.

Modifier les instruments
Style maison > Modifier les instruments vous permet de créer, de modifier ou de supprimer les
types d’instrument.

Pour en savoir plus, b 7.12 Modifier les instruments dans l’ouvrage de référence de Sibelius.

Insérer des instruments
Mise en page > Instruments et portées a été remplacé par Insertion > Instruments dans Sibe-
lius 5, mais a conservé son raccourci I. La boîte de dialogue propose une nouvelle case de contrôle
Petite portée, qui sert à déterminer si une portée doit être ou non de petite taille (Du coup, ce
contrôle qui était présent dans le panneau Portées des propriétés de Sibelius 4 a désormais dis-
paru de cet endroit).
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Numérotation

Les numéros de mesure, les numéros de page et les repères de répétition peuvent désormais se
présenter sous des formats spéciaux utilisés dans certains types de partition.

Numéros de mesure
Agir sur les numéros de mesure s’est considérablement simplifié. Dans les versions précédentes la
fréquence, la position et la présentation des numéros de mesure se réglaient dans quatre boîtes de
dialogue; désormais, la fréquence et la position se règlent dans la page Numéros de mesure de
Style maison > Règles de gravure; la présentation est réglée en éditant le style de texte Numéros
de mesure.

Les numéros automatiques sont désormais traités comme des objets réels et peuvent être sélection-
nés, déplacés et filtrés comme n’importe quel autre objet. Tout numéro de mesure peut être masqué
simplement en le sélectionnant et en choisissant Édition > Masquer ou afficher > Masquer.

Pour en savoir plus, b 3.6 Numéros de mesure dans l’ouvrage de référence de Sibelius.

Changements de numéros de mesure
Insertion > Autre > Changement de numéro de mesure s’est agrandi en proposant un éventail
de nouvelles options évoluées:

* Vous pouvez désormais créer des numéros de mesure dans différents formats dont 1a, 1b, 1c…,
1A, 1B, 1C…, a, b, c… et A, B, C…

* Vous pouvez désormais ajouter du texte avant et après des numéros de mesure (par ex. 1 nou-
veau, 2 nouveau, 3 nouveau… ou alt 1, alt 2, alt 3…)

* Vous pouvez créer un changement de mesure qui n’augmente pas la numérotation, ce qui s’uti-
lisera pour les cas spéciaux tels que la scission d’une mesure par un saut de système, via la nou-
velle option Ne pas numéroter cette mesure.

* Sibelius affiche désormais correctement une étendue de numéros de mesure sous une mesure de
comptage si la première mesure des mesures comptées contient un changement de numéro de
mesure et les étendues de numéros de mesure sous les mesures de comptage sont toujours posi-
tionnées sous la portée si elles sont réglées pour être centrées.

Sélectionner un passage avant de créer un changement de numéro de mesure dans un format alter-
natif (par ex.1a, 1b, 1c…) entraînera dans la mesure suivant la sélection, la remise en route par
Sibelius du format de numéro de mesure original.

Nouvelles règles de gravure pour les numéros de mesure
Toutes les options concernant la présentation et la position des numéros de mesure se règlent à la page
Numéros de mesure de Style maison > Règles de gravure, dont les nouvelles options suivantes:

* La nouvelle option Prendre en compte les reprises permet à la numérotation de prendre en
compte dans une partition les structures répétées et de les afficher de différentes manières

* Pour placer les numéros de mesure sous la portée inférieure, il suffit de choisir l’option sous la
portée inférieure dans la liste du cadre Portées sélectionnées

* On peut définir un intervalle d’apparition des numéros de mesure (par ex. toutes les 8 ou 16 mesures)
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* La nouvelle option Masquer aux repères de répétition masque automatiquement les numéros
de mesure aux barres de mesure sur lesquelles les repères de répétition sont présents

* Quand les numéros de mesure sont réglés pour être centrés dans la mesure, les changements de
numéros de mesure le sont désormais aussi.

Aller à la mesure
Édition > Aller à la mesure est maintenant plus pratique dans les partitions qui contiennent plu-
sieurs chansons, mouvements ou morceaux pour lesquels la numérotation des mesures recom-
mence à 1; en effet, répéter le même numéro de mesure, sélectionne l’une après l’autre toutes les
mesures de la partition qui portent ce numéro, ce qui permet de naviguer plus faci-lement dans les
partitions qui contiennent des changements de numéro de mesure.

Numéros de page
Sibelius 5 permet de renuméroter, de changer le format des numéros de page ou de les masquer
n’importe où dans une partition. Par exemple, vous pouvez numéroter les pages d’introduction
d’une partition i, ii, iii… ou a, b, c…, puis les pages de musique avec 1, 2, 3..., en utilisant la nou-
velle fonction Insertion > Autre > Changement de numéro de page.

Vous pouvez choisir si les numéros de page sont masqués ou affichés et relancer la numérotation à
partir de n’importe quelle page selon un numéro quelconque dans n’importe quel format. Créer un
changement de numéro de page crée automatiquement un saut de page dans la partition.

Les numéros de page peuvent désormais être masqués ou affichés comme d’autres objets, en uti-
lisant les options Édition > Masquer ou afficher. Masquer ou afficher le premier numéro de page
d’un changement de numéro de page ne masque ou n’affiche que ce premier numéro; masquer/
afficher tout numéro de page suivant masque/affiche tous les numéros de page de ce changement.

De plus :

* Édition > Aller à la page permet désormais d’aller à une page de tout format de numéro de page
* Les nouvelles options de la page Mise en page de Présentation des parties multiples per-

mettent de choisir si les changements de numéro de page apparaissent ou non dans les parties
dynamiques; si c’est non, vous pouvez y spécifier le numéro de la première page de chaque partie.

* La page Numéros de page de Style maison > Règles de gravure a été supprimée et remplacée
par la nouvelle fonction Insertion > Autre > Changement de numéro de page.

Pour en savoir plus, b 3.7 Numéros de page dans l’ouvrage de référence de Sibelius.

Repères de répétition
Les nouvelles commandes Préfixe et Suffixe de la page Repères de répétition de Style maison >

Règles de gravure facilitent l’utilisation de polices qui placent un cadre manuscrit autour des
repères de répétition (comme la nouvelle police Reprise Rehearsal– voyez Reprise et les autres
polices à la page 48).

Vous pouvez aussi créer des caractères supplémentaires avant ou après le composant automatique
d’un repère de répétition, par exemple pour produire des séquences telles que 1A, 2A, 3A, etc..., en
utilisant les commandes Nouveau préfixe/suffixe de Insertion > Repères de répétition.

Pour en savoir plus, b 3.8 Repères de répétition dans l’ouvrage de référence de Sibelius.
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Reprise et les autres polices

Reprise™
Reprise est la dernière police de la gamme en pleine expansion de polices élégantes produite par
Sibelius. En fait, Reprise est une famille de neuf polices qui simulent de manière étonamment réa-
liste l’écriture manuscrite. Les symboles musicaux sont dessinés en imitant le tracé d’une plume de
largeur fixe (contrairement à celle en italique utilisée dans Inkpen2), et pour les titres et les textes
de grande taille deux polices imitent l’impression au tampon..

Reprise comporte des caractères spéciaux et des extensions pour les lignes manuscrites et l’enca-
drement des textes et des repères de répétition; des styles maisons sont proposés pour incorpoer
Reprise dans les partitions. Cette police est surtout une belle reproduction de l’écriture manuscrite
des copistes dans un style qui convient parfaitement à la musique de jazz, les lead sheets, les parti-
tions de big band, et de music-hall.

Pour en savoir plus, b 7.7 Style maison dans l’ouvrage de référence de Sibelius.

Opus Note Names
La nouvelle police Opus Note Names s’utilise pour écrire le nom des notes sur la tête de note
comme ceci:

C’est l’idéal pour l’apprentissage de la lecture par les élèves instrumentistes débutants. Pour utiliser
la nouvelle police, sélectionnez le passage qui doit recevoir le nom des notes, ou la partition entière
et choisissez Extensions > Divers > Ajouter le nom des notes sur la tête de note



Concert

Swing (q = 200)

Just WaSTin’ tIme
“Itchy” Pete Milligan

  
Dm

        
G9
 {M`u`t`e`}

      
C11(b9)

 

[A]

5

1.  
Am7

   
Dº

    
Gm/Bb

  
F13

  

 
   

 




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Pour en savoir plus, b 5.11 Extensions dans l’ouvrage de référence de Sibelius.

Symboles d’accord
Il existe deux nouvelles polices pour les symboles d’accord: Opus Chords Sans et Opus Chords Sans
Condensed, toutes deux avec des caractères sans serif normaux et condensés, comme Arial ou Hel-
vetica. D’autres caractères supplémentaires peuvent maintenant être incorporés dans les symboles
d’accord.

Pour en savoir plus, b 3.4 Symboles d’accord dans l’ouvrage de référence de Sibelius.

Musique ancienne & d’avant garde
Sibelius 5 propose désormais dans ses nouvelles polices Opus Ornaments et Opus Special Extra,
plus de 200 symboles supplémentaires pour la musique ancienne et contemporaine, que voici:

Pour en savoir plus, b 2.26 Symboles dans l’ouvrage de référence de Sibelius.

 
Bb7Bb7

    
EbEb


Fm7Fm7 F#º7F#º7

 
Eb/GEb/G

 
AbAb

  
Fm7Fm7

   
F#º7


Gm7

 
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Analyse fonctionnelle
Les musicologues et les étudiants peuvent maintenant écrire de l’analyse fonctionnelle dans Sibe-
lius 5 grâce à la nouvelle police Opus Function Symbols et le style de texte associé.

Pour en savoir plus, b 3.5 Basse chiffrée et chiffres romains dans l’ouvrage de référence.

Autres améliorations
* Opus Chords et ses polices équivalentes comportent désormais les nouveaux caractères suivants:

% “alt.”, pour les accords altérés (Unicode 00BD)
% Un symbole en ligne oblique pour les têtes de note rythmiques dans les symboles d’accord

(Unicode 00BC)
% Les caractères + et – superposables, comme alternatives à l’utilisation des dièses et des

bémols dans les altérations superposées (Unicode 00F2–00FD)
% le symbole 6/9 pour garder les chiffres alignés plutôt qu’en fraction (Unicode 00DA)
% “4 sur 2” comme alternative à “2 sur 4” (Unicode 00D1)
% Des versions agrandies de °, ± et ² placées sur la ligne de base de la police (Unicode 00B0,

00B1 et 00B2 respectivement)
% Le symbole de mesure répétée pour pouvoir le placer au-dessus de la portée en alignement

avec les symboles d’accord (Unicode 00A3).
Ces symboles figurent dans les menus contextuels des symboles d’accord pour faciliter leur saisie.

* Les chiffres arabes de Opus Roman Chords ont été agrandis pour correspondre aux caractères
alphabétiques afin de les rendre plus lisibles.

* Opus Special et ses polices équivalentes comportent désormais les nouveaux caractères suivants:
% des caractères alternatifs pour les têtes de note obliques (terminaison verticale facilitant l’aligne-

ment avec les hampes) et en losange (blanches et rondes alternatives en notation rythmique).
% des nouveaux symboles de mise en page pour les sauts de pages spéciaux
% un nouveau symbole d’accordéon pour les accouplements à la main gauche.

* Opus Text et ses polices équivalentes comportent désormais un caractère de tilde, un signe spé-
cial d’égalité avec des points au-dessus et en dessous des lignes pour signifier “circa,” et deux
moitiés de symbole de mesure en H (entre les signes d’accolades { et }) pour écrire les avertisse-
ments aux pages de tourne spécifiant le nombre de mesures de silence à la page suivante.

* Opus Metronome et ses polices équivalentes comportent désormais des caractères de parenthèses.
* L’alignement des chiffres d’indications de mesure dans Helsinki a été amélioré.
* La position et la largeur de la ligne du texte souligné dans Inkpen2 Script sont désormais correctes.
* Les symboles de diagramme d’accord vide dans Inkpen2 Special sont à présent corrects.




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Extensions

Il est maintenant possible d’annuler les extensions, donc n’hésitez pas à les utiliser! Pour annuler le
résultat d’une extension, il suffit de choisir Édition > Annuler après avoir l’avoir utilisée.

Le langage ManuScript utilisé pour les extensions de Sibelius a aussi été substantiellement
amélioré, ce qui signifie que les extensions peuvent accomplir des opérations plus complexes –
consultez la documentation séparée Utiliser le langage Manuscript pour en savoir plus.

Sibelius 5 propose pas moins de 20 nouvelles extensions. Chacune de celles-ci est décrite en détail
dans l’ouvrage de référence de Sibelius – b 5.11 Extensions pour en savoir plus.

Symboles d’accord
Le dossier Extensions > Symboles d’accord est un nouveau dossier. Y figurent logiquement trois
extensions déjà existantes (Ajouter des symboles d’accord, Réalisation des symboles
d’accord et des diagrammes, Symboles d’accord sous forme de fractions) désormais plus
faciles à retrouver, et une nouvelle extension, Ajouter des capos aux symboles d’accord, qui
écrit des symboles d’accord appropriés au-dessus des portées de guitare avec des jeux de capos aux
positions de frette spécifiques.

Il y a cinq nouvelles extensions dans le dossier Extensions > Outils de composition:

* Ajouter une portée de point de montage crée une nouvelle portée d’une ligne dans la parti-
tion et y crée une note dont la position rythmique correspond à chaque point de montage de la
partition. Ceci facilite la visualisation de la position rythmique exacte de chaque point dans une
mesure.

* Distribution divise la musique d’une portée sur plusieurs portées. Cette extension vient en com-
plément du style d’arrangement existant “distribuer”, en apportant un contrôle accru sur la
manière dont chaque note est distribuée vers chaque instrument.

* Ajuster une sélection selon la durée détermine pour un passage donné sa durée ou le moment
auquel il se termine, créant un changement de tempo si nécessaire; cette extension est indispen-
sable pour le travail avec de la vidéo.

* Réduction condense la musique d’un grand nombre de portées sur une seule. Comme la nouvelle
extension Distribution, elle vient en complément du style d’arrangement “réduction”, en apportant
un contrôle accru.

* Transformer une gamme à partir d’une sélection de notes en transforme la gamme (par ex.
maj.) en une autre (par ex.pentatonique), chaque note étant transposée de manière adéquate.

Divers
Cinq nouvelles extensions figurent dans le dossier Extensions > Divers:

* Ajouter le nom des notes sur la tête de note installe les noms des notes sur la tête de note de
chaque note de la partition en utilisant la police spéciale Opus Note – voyez Reprise et les
autres polices à la page 48.

* Marqueurs pour Groovy Music installe des indications dans les partitions Sibelius de manière
à en assurer une importation correcte vers les programmes de la gamme Groovy destinée à
l’apprentissage élémentaire
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* Créer une mise en page pour piano à quatre mains réalise à partir d’une partition écrite
pour deux pianos (ou n’importe quel instrument à deux claviers) une nouvelle partition dans le
format conventionnel de la musique pour piano à quatre mains, avec la partie du premier pia-
niste (partie supérieure) sur les pages de droite et celle du second (partie inférieure) à gauche

* Diviser une mesure divise une mesure en deux, ce qui est utile par exemple pour scinder une
mesure entre deux systèmes ou entre deux pages

* Proposer des emplacements de réplique détermine les emplacements adéquats pour des
répliques sur base du nombre de mesures de silence ou sur un décompte de silences d’une durée
minimum (en minutes et secondes), et les indique dans la partition – cf. Répliques à la page 41.

Exécution
La nouvelle extension Extensions > Exécution > Ajouter un changement de contrôleur con-
tinu, peut ajouter un large éventail de messages MIDI dans la partition pour automatiser les effets
spéciaux ou complexes présents dans les bibliothèques de tierce partie, telles que celles de Garritan
Jazz et Big Band.

Corrections d’épreuves
Il y a deux nouvelles extensions dans le dossier Extensions > Correction d’épreuves:

* Vérifier les répliques vérifie si une réplique collée correspond à la portée d’origine dont elle
provient – cf. Répliques à la page 41

* Vérifier les césures dans les paroles vérifie si les paroles de la partition ont des césures cor-
rectes, et les corrige éventuellement automatiquement.

Simplifier la notation
Un nouveau dossier Extension > Simplifier la notation a été créé, pour permettre de retrouver
plus facilement plusieurs extensions existantes (Combiner des notes liées et des silences,
Notes en double sur des portées, Enlever les notes redondantes, Enlever les silences,
Supprimer les unissons); ont été aussi ajoutées trois nouvelles extensions:

* Réécrire une exécution enregistrée peut être utilisé avec toute musique saisie via Flexi-time
ou résultant d’une importation d’un fichier MIDI, et est particulièrement efficace avec de la
musique pour clavier (sur deux portées). Après examen des durées, point de scission, répartition
des voix, etc... cette extension réalise une simplification générale de la musique ce qui la rend
bien plus lisible.

* Déplacer sur l’autre portée déplace une note d’une portée de piano ou d’un autre instrument à
clavier vers l’autre portée. Elle est très pratique pour les notes mal placées après une saisie via
Flexi-time ou suite à une importation MIDI.

* Changer le point de scission permet d’ajuster le point de scission entre les portées d’un instru-
ment à clavier d’une sélection donnée, pour déplacer sur l’autre portée les notes situées au-des-
sus ou en dessous d’une note de hauteur spécifiée.

Texte
La nouvelle extension Extensions > Texte > Ajouter des parenthèses dans les scripts de
reprise, insère automatiquement les caractères nécessaires dans les objets textuels de la partition,
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à savoir les parenthèses et les lignes caractéristiques de l’écriture manuscrite du jazz – cf. Reprise
et les autres polices à la page 48.

Multiplets
Un nouveau dossier Extensions > Multiplets a été créé dont voici les huit nouvelles extensions:

* Ajouter des notes dans des multiplets permet d’ajouter des notes dans le multiplet sélec-
tionné en lui conservant sa durée totale (c’est-à-dire en augmentant son rapport)

* Changer le rapport d’un multiplet change le rapport d’un multiplet en conservant la même
durée (par ex. le rapport 3:2 devient 3:4, 6:4 devient 6:8, etc..)

* Allonger un multiplet allonge un multiplet en le combinant avec les notes présentes sur l’un de
ses côtés. 

* Raccourcir un multiplet raccourcit un multiplet en prenant des notes et en les réécrivant en
dehors du crochet du multiplet

* Enlever les notes d’un multiplet enlève des notes d’un multiplet sélectionné tout en conser-
vant sa durée totale (c’est-à-dire en diminuant son rapport)

* Raccourcir un multiplet raccourcit un multiplet en prenant des notes et en les réécrivant en
dehors du crochet du multiplet

* Diviser ou joindre des multiplets divise un seul multiplet en multiplets plus petits, ou joint
deux ou plusieurs multiplets adjacents en un seul plus long

* Préférences des multiplets spécifie les préférences utilisées par toutes les autres extensions du
sous-menu Extensions > Multiplets.

Autres extensions mises à jour
Plusieurs extensions ont été mises à jour dans Sibelius 5, à savoir:

* Les trois extensions du dossier Extensions > Altérations – Simplifier les altérations, Réor-
thographier les bémols en dièses et Réorthographier les dièses en bémols – ont été mises
à jour de manière à ne plus interférer sur les données d’exécution, les groupements de ligature et
les têtes de note traitées par chaque extension.

* Les extensions du dossier Traitement global produisent toujours des noms de fichier avec
l’extension correcte, même si le nom de fichier contient un ou plusieurs points avant l’extension
du fichier.

* Extensions > Traitement global > Calcul de statistiques (une extension bien pratique qui sera
appréciée entre autres par les copistes) produit des statistiques pour une seule partition ou un
dossier complet de partitions et exporte désormais un fichier texte plutôt que de produire une
partition dans laquelle sont écrits les résultats.

* Extensions > Traitement global > Convertir un dossier de partitions en images peut main-
tenant exporter au format d’images PNG.

* Extensions > Symboles d’accord > Réalisation des symboles d’accords et des dia-
grammes positionne désormais de meilleure façon le nouvel accompagnement, permet
d’ajouter un nouveau style d’accompagnement de piano (main gauche uniquement) et peut être
lancée quand Notes > Partition transposée est activée.
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* Extensions > Outils de composition > Ajouter une harmonie élémentaire positionne
désormais les nouveaux instruments créés sous les autres portées de la partition.

* Extensions > Outils de composition > Table des hauteurs de note peut désormais traiter les
enharmonies de manière adéquate.

* Extensions > Outils de composition > Rétrograde peut désormais traiter les passages qui con-
tiennent des triolets et autres multiplets.

* Extensions > Notes et silences > Ajouter des têtes de note obliques dans les parties peut
désormais traiter les multiplets et les changements d’instruments et prévenir l’utilisateur s’il tra-
vaille par mégarde sur une partie dynamique.

* Extensions > Notes et silences > Combiner les notes liées et les silences combine désor-
mais tous les silences d’une mesure pour en faire une mesure de silence quand c’est possible.

* Extensions > Notes et silences > Doubler/diviser la valeur des notes peut désormais traiter
les triolets et autres multiplets.

* Extensions > Divers > Ajouter des pédales de harpe possède désormais une option pour
déterminer si les cordes inutilisées affichent ou non les pédales dans les positions bémol ou
naturel; l’algoritme pour déterminer le temps écoulé entre les diagrammes de pédale a été
amélioré.

* Extensions > Divers > Gammes et arpèges a été améliorée de sorte que les partitions produites
par l’extension n’ont plus de changements d’armure visibles et des double barres sont présentes
entre les gammes.

* Extensions > Correction d’épreuve > Correction d’épreuve peut maintenant lancer la nou-
velle extension Vérifier les répliques.

* Extensions > Texte > Modifier les nuances peut changer les nuances à la fois dans les polices
Helsinki Text et Reprise Text.

* Extensions > Texte > Sauvegarder les paroles a été renommé en Exporter les paroles, ce qui
est plus cohérent avec les autres fonctions du programme.

* Extensions > Texte > Guillemets embellis ne provoque plus la perte de sauts de ligne dans les
objets textuel de plusieurs lignes.
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Interface

Si vous faites la mise à jour depuis Sibelius 4, l’interface de Sibelius 5 vous paraîtra immédiatement
familière, avec quelques changements qui ne devraient en rien vous perturber. Si la mise à jour se
fait depuis une version plus ancienne, plusieurs changements sont évidents. Il s’agit d’améliora-
tions afin de rendre l’utilisation du logiciel plus rapide et plus confortable.

Barre d’outils
La barre d’outils propose maintenant les contrôles suivants:

Le seul nouveau bouton ajouté depuis Sibelius 4 est celui de Panorama, juste à droite du menu
zoom.

À droite de la barre d’outils voici le nouveau groupe de boutons à utiliser pour masquer ou afficher
les huit fenêtres flottantes d’outil de Sibelius:

Ces boutons correspondent aux options du menu Fenêtre, et tous possèdent un raccourci-clavier.

Le seul changement consiste en la disparition du bouton Kontakt Player; à la place se trouve le
bouton de la nouvelle fenêtre des idées.

Menus
Quelques éléments de différents menus ont été simplement renommés ou déplacés dans d’autres
menus. Voici les changements les plus importants depuis Sibelius 4 :

* Mise en page > Instruments et portées a été déplacé dans Insertion > Instruments, mais a
conservé I comme raccourci-clavier 

* Mise en page > Portées en vue ciblée a été déplacé dans Affichage > Portées en vue ciblée,
mais a conservé Ctrl+Alt+F ou zXF comme raccourci-clavier

* Les options des périphériques d’entrée ont été déplacées de la page Périphériques d’entrée de
Exécution > Exécution et périphériques d’entrée vers une nouvelle page Périphériques dans
Fichier > Préférences (dans le menu Sibelius sur Mac)

Nouveau
Numériser

Exporter l’audio

Ouvrir
Sauvegarder

Imprimer

Annuler

Rétablir

Zoom

 Zoom en cours Portées en 
vue ciblée

Partie en cours

Basculer entre
cond./parties

Référence

Masquer/afficher les 
fenêtres d’outils

Partition 
transposéePanorama

Navigateur

Pavé

Exécution

Table de mixage

Idées

Parties

Vidéo

Propriétés

Masquer 
les fenêtres 
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* Fenêtre > Kontakt Player a été enlevé puisque Sibelius peut maintenant utiliser d’autres instru-
ments virtuels; vous pouvez afficher la nouvelle fenêtre de Kontakt Player 2 (et celle d’autres
instruments virtuels ) via la nouvelle fenêtre de la table de mixage.

Tous les détails sont exposés dans Annexe B: changements dans les menus à la page 77, et
notamment tous les changements apportés aux menus depuis les versions antérieures de Sibelius.

Raccourcis-clavier
Même si plusieurs nouveaux raccourcis-clavier ont été ajoutés dans cette mise à jour, un seul rac-
courci-clavier a été changé depuis Sibelius 4: Maj-P est désormais le raccourci pour Affichage >

Panorama, et Exécution > Interprétation n’a plus de raccourci-clavier.

Si vous faites une mise à jour depuis une version plus ancienne que Sibelius 4, les nouveaux rac-
courcis-clavier utilisés sont plus nombreux – vous en trouverez tous les détails dans Annexe C:
raccourcis-clavier à la page 78.

Saisie des notes
Il n’y a aucun changement significatif pour la saisie des notes dans Sibelius 5. Une seule nouvelle
fonction bien pratique est apparue:si vous avez sélectionné un passage avant d’insérer une clef, une
indication de mesure ou une armure, Sibelius rétablira la clef, l’indication de mesure ou l’armure
originale à la fin du passage sélectionné. Cela fonctionne indépendamment de la longueur du pas-
sage, de sorte que si vous cliquez sur une partie vide d’une mesure (pour faire une sélection de pas-
sage d’une mesure) avant de créer un de ces objets, Sibelius réta-blira automatiquement l’objet
original à la fin de la mesure. Si éventuellement vous ne souhaitez pas que cela se produise, et que
vous voulez éviter que les objets soient rétablis à la fin des sélections d’une mesure ou moins, dés-
activez Rétablir les caractéristiques originales après sélection de mesure simple dans la
page Saisie des notes de Fichier > Préférences (dans le menu Sibelius sur Mac).

Si la mise à jour se fait depuis Sibelius 2 ou 3, il y a plusieurs changements significatifs introduits
dans Sibelius 4, dont vous devez être informé: espace n’est plus utilisé pour la saisie des silences. À
la place, la touche 0 key du pavé numérique est utilisée pour la saisie des silences. Cela signifie que:

* Dans les versions précédentes, taper 0 sur le pavé numérique avec une ou plusieurs notes sélec-
tionnées basculait la sélection en silence et vice-versa.

* Dans les versions précédentes, taper espace avec une note sélectionnée affichait le signe d’inser-
tion après la note sélectionnée, ce qui permettait de continuer la saisie depuis cet endroit.

* Si vous utilisez un portable qui ne possède pas de pavé numérique, nous vous recommandons de
choisir le jeu de fonction Fonctions de portable dans la page Menus et raccourcis de
Fichier > Préférences, qui assigne les fonctions du pavé numérique à la rangée des touches
numériques du clavier principal (Windows uniquement).

Pour connaître la manière pour faire en sorte que Sibelius 5 se comporte le plus possible comme
Sibelius 3 ou Sibelius 2 lors de la saisie des notes en utilisant des raccourcis, consultez http://
www.sibelius.com/helpcenter/en/a481. Mais naturellement ne vous le recommandons pas: il
vaut bien mieux apprendre les nouveaux raccourcis de saisie des notes.

Pour obtenir plus d’informations sur la personnalisation des raccourcis-clavier de Sibelius, b 5.9
Menus et raccourcis dans l’ouvrage de référence de Sibelius.

http://www.sibelius.com/helpcenter/en/a481
http://www.sibelius.com/helpcenter/en/a481
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Navigateur
Si vous faites une mise à jour depuis Sibelius 3 ou une version antérieure, sachez que le fonctionne-
ment de la fenêtre du navigateur s’est modifié dans Sibelius 4.

Dans les versions précédentes, pour avancer sur de longues distances (plus de deux pages) il fallait
déplacer la souris continuellement; donc pour de très longues distances la souris devait quitter le
bureau alors que le bouton devait resté enfoncé et qu’il fallait assez d’espace pour continuer le
déplacement! Cette méthode était plutôt fatigante.

Désormais, le navigateur dispose de zones de défilement à gauche et à droite. Pour se déplacer sur
plus de deux pages, gardez le bouton de la souris enfoncé puis déplacez le pointeur sur l’une des
extrémités du navigateur et Sibelius commencera à défiler. Dès qu’il commence le défilement, con-
servez le pointeur dans la même position et Sibelius continuera le déplacement; si le pointeur est
déplacé encore un peu plus dans la même direction le défilement s’accélèrera.

Si ce nouveau fonctionnement du navigateur ne vous convaint pas tout de suite, pourquoi ne pas
essayer une des autres méthodes de navigation rapide dans Sibelius? Par exemple, taper Début et
Fin déplace la partition à gauche ou à droite d’un écran ou d’une page à la fois; Ctrl+Début ou X4

ramène au début de la partition et Ctrl+Fin ou X7 déplace jusqu’à la fin de la partition; Page vers
le haut et Page vers le bas (8 et 9 sur certains claviers Mac) déplace la partition vers le haut ou
vers le bas; Ctrl+Page vers le haut ou X8 déplace au sommet de la page et Ctrl+Page vers le
bas ou X9 déplace vers le bas de la page. Vous pouvez aussi activer Affichage > Barres de défile-
ment, celles-ci permettent de se déplacer jusqu’à n’importe quel point de la partition. Et si votre
souris possède un bouton à molette, vous pouvez l’utiliser pour le déplacement vertical, pour le
déplacement horizontal avec Maj enfoncé, et pour le zoom avec Ctrl ou X.

Améliorations supplémentaires sur Mac 
Sibelius 5 est une application universelle, ce qui signifie qu’elle fonctionne à plein rendement sur
Mac OS X et les processseurs PowerPC et Intel. Sibelius 5 tire parti des dernières technologies
Apple à savoir:

* La présentation des éléments des boîtes de dialogue a été améliorée, en utilisant les plus récents
contrôleurs de la “Human Interface Toolbox” destinés aux listes, listes déroulantes et autres
menus pop-up.

* Les éléments de boîte personnalisée (par ex. la liste de symboles de Insertion > Symboles, la
liste de clefs de Insertion > Clef, la prévisualisation de la partition Mise en page > Paramètres
du document, etc.) s’affichent désormais bien mieux grâce à Quartz.

* Il est désormais possible d’utiliser X. comme équivalent de Échap dans toutes les boîtes de dia-
logue qui affichent un bouton Annuler.

* Les noms de menu de la barre des menus ne s’allument plus quand on insère du texte dans la
partition.

* Quelques problèmes de présentation d’éléments et de contrôleurs présents dans des boîtes de
dialogue ont été résolus.

* Sibelius utilise désormais uniquement Quartz pour un affichage le plus clair et le plus fluide pos-
sible. L’optimisation OpenGL n’est plus disponible.
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Autres améliorations
* Quand Sibelius est en cours de chargement, des messages sur l’écran d’accueil vous informe de

ce qui est en train de se produire.
* La page Textures de Fichier > Préférences (dans le menu Sibelius sur Mac) a été changée de

manière à ce que l’on puisse régler indépendamment les textures du bureau et du papier pour le
conducteur, les parties dynamiques et les idées en cours de modification avec une prévisualisa-
tion du résultat graphique dans la boîte de dialogue.

* Les boîtes de dialogue utilisent de manière appropriée des cadres regroupés standards plutôt que
des séparateurs de ligne.

* Les boîtes de dialogue standard dont le bouton Annuler n’existe plus se confirme désormais en
cliquant sur Fermer, pour éviter que des boîtes proposent un bouton OK et d’autres un bouton
Fermer.

* Aide > Grove Music a été supprimé.
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Autres améliorations et bogues résolus

Les autres nouvelles fonctions et améliorations présentes dans Sibelius 5 sont résumées ci-dessous
par ordre alphabétique.

Pour en savoir plus, voyez la section appropriée dans l’ouvrage de référence de Sibelius, soit dans la
version imprimée (si vous l’avez achetée) ou à l’écran en choisissant Aide > Référence de Sibelius
(raccourci F1 ou X?).

Aide
Aide > L’ouvrage de référence de Sibelius se consulte désormais sous forme de fichier PDF
plutôt que sur le système de page web utilisé dans Sibelius 4. Cela en accélère l’ouverture et facilite
la consultation.

Altérations
Quand les notes de deux voix se rencontrent dans une mesure et que l’une des voix est en note de
réplique, les altérations des notes de cette voix sont désormais à la bonne taille.

Armures
Quand on crée une sélection de passage contenant une nouvelle armure, Sibelius rétablit automa-
tiquement l’armure originale à la fin de la sélection.

Articulations
* Vous pouvez désormais définir le comportement de chaque type d’articulation dans la nouvelle

page Articulations de Exécution > Dictionnaire – cf. Exécution à la page 28.
* Les articulations peuvent être désormais placées du bon côté des notes quand des ligatures

enjambant les portées sont utilisées
* Déplacer les notes entre les voix en utilisant Alt+2 ou z2 etc. n’entraînent plus la perte des

articulations.

Clefs
* Insertion > Clef permet maintenant de créer des clefs en fonction de l’activation ou non de

l’option Notes > Partition transposée, ce qui est très pratique pour les instruments à vents et
les cuivres graves, qui sont en général écrits dans des clefs différentes selon que la partition est
en sons réels ou en sons écrits.

* Quand on crée une sélection de passage contenant un changement de clef, Sibelius rétablit
automatiquement la clef originale à la fin de la sélection.

Exporter des fichiers audio
Sibelius peut désormais exporter des fichiers audio “off-line,” c’est-à-dire sans être en temps réel.
Pour des fichiers audio relativement simples, cela signifie qu’ils seront exportés plus rapidement
qu’en temps réel; pour les fichiers audio plus lourds, ce sera moins rapide qu’en temps réel mais le
résultat sera exempt de parasites. Cela signifie surtout qu’en évitant de devoir le faire en temps réel
même vos fichiers audio complexes pourront être compilés par votre ordinateur.
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Exporter des fichiers d’images
* Sibelius peut désormais exporter des images au format Portable Network Graphics (PNG) via

Fichier > Exporter > Images.
* Sibelius peut désormais exporter sur Mac des images au format Windows bitmap graphics

(BMP) via Fichier > Exporter > Images.
* Les options de la boîte de dialogue Fichier > Exporter > Images peuvent être modifiées en cours

de session.
* Sibelius n’exporte plus au format EMF graphics (Windows uniquement).

Exporter des fichiers MIDI 
* Sibelius peut désormais exporter un fichier MIDI conçu pour être exécuté avec n’importe quel

type de jeux de sons sans devoir ajuster les réglages d’exécution de la partition. Par exemple, si
vous travaillez avec Sibelius Sounds Essentials dans Kontakt Player 2 (qui n’est pas compatible
avec le format General MIDI) mais que vous voulez exporter un fichier MIDI destiné à être joué
sur un lecteur media standard, vous pouvez choisir d’exporter un fichier MIDI compatible avec
le format General MIDI en sélectionnant le jeu de sons General MIDI dans la boîte de dialogue
Exporter les options du fichier MIDI. À l’inverse, si vous utilisez une bibliothèque d’échantil-
lons et que vous voulez exporter un fichier MIDI pour continuer à travailler dessus avec un
séquenceur, en concevant un fichier MIDI avec le jeu de sons en cours, toutes les touches de con-
trôle existantes et les contrôleurs MIDI, vous conserverez tous ces réglages lors de l’exportation
ce qui vous évitera de devoir tout reprogrammer dans votre séquenceur.

* Sibelius peut désormais exporter les deux types de format de fichier MIDI, les types 0 et 1
(auparavant, seul le type 1 était possible), ce qui se détermine dans la nouvelle boîte de dialogue
Exporter les options du fichier MIDI.

* La résolution de l’impulsion MIDI (le nombre d’impulsions par noire, ou PPQN) des fichiers
MIDI peut désormais être réglée via la nouvelle boîte de dialogue Exporter les options du
fichier MIDI.

Fichiers
* La taille des fichiers de partitions Sibelius 5 s’est considérablement réduite, jusqu’à 50% par rap-

port aux fichiers des versions précédentes.
* Quand une partition est sauvegardée pour la première fois, Sibelius suggère désormais automa-

tiquement un nom de fichier, basé sur le champ Titre dans Fichier > Infos sur la partition s’il
est rempli ou sinon d’après le texte de titre figurant dans la partition.

* Sibelius 5 peut exporter des partitions au format Sibelius 4, Sibelius 3 (ou Sibelius Student ou
G7), et Sibelius 2, via l’option du menu Fichier > Exporter > Sibelius 2, 3, 4 ou Student.

* La nouvelle option Ne pas tenir compte des objets masqués pour l’orientation de
hampes et le placement des silences de la boîte de dialogue Style maison est proposée dans
la boîte de dialogue Mise à jour de la partition qui apparaît lors de l’ouverture de partitions
créées dans des versions précédentes de Sibelius.

* Le bouton Ajouter des instruments de la première page de Fichier > Nouveau a été renommé
en Changement d’instruments pour rendre plus évident qu’il est possible de cette manière
d’ajouter ou d’enlever des instruments dans les papiers à musique.
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* L’option Créer une page de titre de la page finale de Fichier > Nouveau crée désormais une
page de titre en utilisant un saut de page spécial (cf. Sauts ci-dessus).

* Quand on ouvre la boîte de dialogue Fichier > Informations sur la partition le champ Titre est
désormais actif permettant à l’utilisateur de taper directement dedans sans devoir activer le con-
trôle de l’édition (Mac uniquement).

* Le nouveau champ Changements d’instrument dans la boîte de dialogue Fichier > Informa-
tions sur la partition, énumère la liste des changements d’instruments utilisés dans le conduc-
teur ou la partie en cours. Ceci correspond aux textes des nouvelles formules magiques
\$InstrumentChanges\ et \$HeaderInstrumentChanges\, qui peuvent être bien pratiques
dans les parties dynamiques (par exemple si le Nom de partie est “Anches 1” et les Change-
ments d’instrument sont “Clarinette, Saxophone alto”). D’autres nouveaux champs de Infor-
mations sur la partition proposent Dédicace, Artiste, Année de composition, Dates du
compositeur, Numéro d’opus, Copiste.

* Dans les partitions très grandes (avec beaucoup de portées de taille très petite sur une page très
grande), il arrivait qu’il ne soit pas possible de voir la fin de la partition. Ce problème est désor-
mais résolu.

* L’efficacité de la commande Fichier > Adjoindre une partition a été très améliorée par rapport
aux versions antérieures, et cela pour éviter les plantages qui pouvaient se produire.

Filtres
* Le nouveau filtre rapide Édition > Filtre > Numéros de mesure permet de sélectionner tous les

numéros de mesure d’une sélection (cf. Numérotation à la page 46).
* Le nouveau filtre rapide Édition > Filtre > Numéros de Page permet de sélectionner tous les

numéros de mesure d’une sélection (cf. Numérotation à la page 46).

Indication de mesure
* Insertion > Indications de mesure propose désormais en option par défaut la case de contrôle

Réécrire les mesures jusqu’au changement de mesure suivant plutôt que de vous
demander de cliquer sur OK après vous avoir systématiquement posé la question chaque fois
que ce cas se présente.

* Quand on crée une indication de mesure dans une sélection de passage, Sibelius rétablit automa-
tiquement l’indication originale à la fin de la sélection.

Imprimer
* La boîte de dialogue Fichier > Imprimer a été réorganisée pour s’afficher dans des résolutions

d’écrans moins élevées, et les raccourcis Alt+lettre des différentes options ont été améliorés
(Windows uniquement).

Importer des images
* Les images TIFF importées en utilisant Insertion > Image peuvent désormais être placées sur

des pages blanches créées avec des sauts de page spéciaux.
* Les images importées via Insertion > Image peuvent être réduites en taille de note de réplique.
* Les images importées via Insertion > Image se mettent désormais à l’échelle des petites portées

auxquelles elles se rattachent.
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Importer des fichiers MIDI
La boîte de dialogue Ouvrir des fichiers MIDI possède désormais une nouvelle option masquer
les portées vides, activée par défaut. Si vous voulez être sûr que toutes les portées s’affichent dans
la partition obtenue après importation du fichier MIDI, désactivez cette option.

Installer Sibelius
* Sibelius utilise désormais le module d’installation standard Windows Installer (MSI), ce qui faci-

lite son déploiement sur les réseaux (Windows uniquement).
* Sibelius nécessite désormais Microsoft .NET Framework 2.0 pour pouvoir être installé. L’assis-

tant d’installation vous réclamera de télécharger la bonne version si elle n’est pas encore installée
(Windows uniquement).

Interprétation
* On y trouve une nouvelle option, Convertir les vélocités de l’exécution en nuances pour les

instruments qui soutiennent le son dans Exécution > Interprétation. Quand elle est activée,
cette option signifie que les vélocités de l’exécution enregistrée sont converties en nuances plutôt
qu’en attaque pour les instruments qui tiennent les notes et utilisent la molette de modulation
pour le volume (par exemple dans Garritan Personal Orchestra).

Ligatures
La nouvelle option Ajuster les ligatures chevauchant les portées et entre les notes de la page
Ligatures et hampes de la page Style maison > Règles de gravure, résoud deux problèmes: les
ligatures n’apparaissent plus du mauvais côté des têtes de note quand les ligatures enjambent des
portées; les hampes sont placées du bon côté de la tête de note dans le cas de ligature placée entre
une note très grave et une autre très aiguë sur la même portée. Cette option est activée par défaut
dans les nouvelles partitions.

Lignes
* Vous pouvez maintenant modifier l’ouverture des soufflets individuellement, en utilisant les

nouveaux contrôles du panneau Lignes des propriétés. La terminaison fermée, la terminaison
ouverte, les ouvertures de continuité petite et grande peuvent être modifiées séparément. Le
réglage de terminaison Fermé plus grand que 0 produit des soufflets “ouverts” utilisés par cer-
tains compositeurs contemporains.

* Lors de l’exécution les soufflets déterminent automatiquement la nuance à laquelle ils aboutis-
sent, soit en se référant à la nuance explicite qui viendrait juste après, soit en son absence, par
diminution ou augmentation du volume.

* Quand on les étend ou qu’on les rétracte avec Espace ou Maj-space, les soufflets se calent juste
avant la fin de la barre de mesure; cela évite, dans le cas d’un saut de page ou de système, qu’ils
débordent un peu sur la première note de la mesure suivante.

* La seconde partie d’un soufflet n’est plus orientée à l’envers après un saut de système ou un saut
de page.

La commande de soufflets Ouverture de continuation des soufflets n grand de la page Lignes
de Style maison > Règles de gravure fonctionne désormais correctement.
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Masquer les objets
Une nouvelle option Ne pas tenir compte des objets masqués pour la direction des hampes
et la position des silences est proposée dans la page Notes et Trémolos de Style maison >

Règles de gravure. Quand cette option est activée, Sibelius ignore les notes et silences masqués
pour décider de l’orientation des hampes et la position verticale des silences des autres voix.

Menu affichage
* La nouvelle commande Affichage > Panorama (raccourci Maj-P), active la fonction Panorama.
* La nouvelle option Ajuster la hauteur de la page est très pratique à utiliser en conjonction

avec la fonction Panorama.

Menu fenêtre
* La commande Fenêtre > Kontakt Player a été enlevée (ainsi que le bouton correspondant sur la

barre d’outils), parce que Kontakt Player 2 et les autres instruments virtuels sont accessibles via
la fenêtre de la table de mixage.

La nouvelle commande Fenêtre > Idées (raccourci Ctrl+Alt+I ou zXI) et le bouton correspon-
dant de la barre d’outils permettent d’afficher ou de masquer – cf. Idées à la page 33.

Mesures de comptage
* Le texte de système attaché à la page (tel que En-tête (après la première page)) n’entraîne plus

la division des mesures de comptage. Dans les versions précédentes de Sibelius, de tels éléments
attachés à une mesure autre que la première entraînait la division des mesures de comptage à
l’endroit de la mesure à laquelle ils étaient attachés; désormais la mesure de comptage n’est plus
divisée et le texte n’est pas affiché dans la partie. Pour être sûr que la mesure ne se divisera pas et
que le texte sera écrit, vérifiez que le texte d’en-tête est attaché à la mesure 1.

* Vous pouvez maintenant changer la largeur d’une mesure de comptage en déplaçant la barre de
mesure de l’une des extrémités, même si la barre de mesure est de type spécial (par ex. une dou-
ble barre de mesure).

Mesures et mesures de silence
La nouvelle fonction Édition > Supprimer des mesures (raccourci Ctrl+RET. ARR ou X-Suppr)
supprime les mesures sélectionnées.

Modifier les jeux de sons
Exécution > Modifier les jeux de sons a été supprimé étant donné les changements importants
de format des fichiers de jeux de sons. Choisissez Aide > Help Center pour visiter notre centre
d’aide en ligne (en anglais) pour en savoir plus sur la manière de créer des jeux de sons personnels.

Modifier les types de portée
Style maison > Modifier les types de portée a été enlevé de Sibelius parce que désormais les
types de portée n’existent plus qu’en relation avec des instruments spécifiques. Pour modifier un
type de portée utilisé par un instrument, utilisez Style maison > Modifier les instruments.

Modifier les styles de textes
* La mention Attaché à de la page Général de Modifier les styles de texte a été enlevée en

faveur d’un affichage du style de texte en cours de modification dans le cadre de capture de la
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boîte de dialogue; désormais on y lit soit Style de texte de portée, Style de texte de
système ou Style de texte de page blanche.

* La page Position verticale de Modifier les styles de texte a été réorganisée pour rendre les
différentes options plus évidentes selon qu’il s’agit de texte de portée, de texte de système ou de
texte de page blanche.

* Une nouvelle case de contrôle Relatif aux marges de la première page exclusivement figure
en même temps dans les pages Position horizontale et Position verticale de Modifier les
styles de texte. Cette option détermine si le texte aligné sur la page qui est “calé” sur les marges
sera toujours positionné à la même position horizontale et/ou verticale que celle de la première
page, ou sera positionné d’après les marges de la page en cours (déterminées par les change-
ments de marge des sauts de page spéciaux).

* La liste de Menu contextuel de la page Général de Modifier les styles de texte se présente
sous forme de liste déroulante si le nombre de menus contextuels disponibles est supérieur à 15.

Modifier les symboles
Cliquez sur Supprimer dans Style maison > Modifier les symboles n’enlèvent plus complète-
ment le symbole mais libère seulement son emplacement.

Numérisation
* PhotoScore peut désormais lire les ligatures enjambant les portées, les lignes de pédale de piano,

les lignes de reprise, les lignes de primo et secundo et d’autres nouveaux symboles
* PhotoScore Ultimate (le nouveau nom pour PhotoScore Professional) peut lire certaines têtes de

notes manuscrites
* Sibelius importe désormais correctement les mesures de comptage des fichiers PhotoScore
* La position de textes des fichiers importés de PhotoScore a été améliorée
* Les notes au format de notes de réplique dans PhotoScore sont désormais importés correcte-

ment dans Sibelius

Papiers à musique
* On y trouve plusieurs nouveaux papiers à musique, dont Portée basse, Mariachi band,

Orchestre, concert, instrumentarium Orff 1, et instrumentarium Orff 1.
* Les partitions créés dans Sibelius 5 comportent désormais les nouveaux styles de texte suivants

par défaut:
% Le texte de système encadré: ce nouveau style de texte de système convient pour les

instructions encadrées qui s’impriment dans toutes les parties.
% Texte normal de système: ce nouveau style de texte de système convient pour les instruc-

tions générales qui s’impriment par défaut dans toutes les parties.
% Les styles de texte Texte encadré (sur page blanche), Compositeur (sur page blanche),

Dédicace (sur page blanche), Texte normal (sur page blanche), Texte normal à droite
(sur page blanche), Texte normal centré (sur page blanche), Sous-titre (sur page
blanche) et Titre (sur page blanche) s’utilisent sur des pages blanches créées avec les sauts
de pages spéciaux.
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% Nom d’instrument (réplique): ce style de texte de portée s’utilise avec Édition > Coller en
tant que réplique pour indiquer les passages de réplique

% Changement d’instrument: ce style de texte de portée s’utilise avec Insertion > Change-
ment d’instrument pour le nom du nouvel instrument.

% Symboles de fonction: ce style de texte de portée pour l’analyse fonctionnelle utilise la nou-
velle police Opus Function Symbols.

% Modulation métrique: ce nouveau style de texte de système pour écrire les modulations
métriques utilise la police Opus Metronome.

* Les nouvelles partitions créées dans Sibelius 5 ne comportent plus les styles de texte Titre (sur
la page de titre) et Compositeur (sur la page de titre), car ils sont remplacés par les nou-
veaux styles de texte du sous-menu Insertion > Texte > Texte de page blanche. Les vieux styles
de texte continuent d’exister dans les partitions créées dans Sibelius 3 ou 4.

* Dans les nouvelles partitions créées dans Sibelius 5, les textes qui se répètent et sont attachés aux
pages (par ex. les numéros de page, les en-têtes, les pieds-de-page, etc...) sont toujours position-
nés horizontalement et verticalement d’après les marges de page de la première page de la parti-
tion. Si vous voulez que la position d’un objet textuel prenne en compte les changements de
marges de page dans la partition désactivez l’option Relatif aux marges de la première page
exclusivement présente dans les onglets Position horizontale et/ou verticale de Modifier
les styles de texte – voyez Modifier les styles de textes ci-dessus pour en savoir plus. Si
vous voulez que les partitions précédemment créées se conforment aux nouveaux réglages par
défaut, vous devez soit importer un des styles maison proposés avec Sibelius 5, ou activer ces
options pour les styles de texte existants.

* Les nouvelles partitions créées dans Sibelius 5 ont leur nouvelle option ne pas tenir compte
des objets masqués pour la direction des hampes et la position des silences de la page
Notes et Trémolos de Style maison > Règles de gravure activée par défaut.

* Les nouvelles partitions créées dans Sibelius 5 ont l’option Continuation de grand interstice n
dents de la page de Lignes de Style maison > Règles de gravure réglée sur 1.1 .

Paramètres du document
* La nouvelle option Après la première page de Mise en page > Paramètres du document

permet à l’utilisateur de régler les marges supérieures et inférieures (c’est-à-dire le cadre corre-
spondant à l’extension verticale) de la première page indépendamment de toutes les pages sui-
vantes. Cette option est très pratique pour dégager de l’espace au sommet de la page pour le titre
et en bas de la page pour les indications de copyright sans modifier la mise en page des pages
suivantes.

* Il est désormais possible de changer les marges de page et de portées pour des sections de la par-
tition en créant des sauts de page spéciaux. (cf. Sauts ci-dessous).

Paroles
* Pour éviter de devoir taper toutes les paroles dans une partition, vous pouvez désormais les

ajouter directement depuis un fichier texte en utilisant la nouvelle fonction Insertion > Paroles >

À partir d’un fichier texte. Sibelius déterminera la syllabification correcte des mots (pourvu
que le texte soit en anglais, allemand, français, espagnol ou latin) et le collera dans la partition,
en tenant compte des liaisons de phrasé afin de produire des mélismes.
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* Des paroles collées dans le presse-papiers peuvent aussi se placer automatiquement avec les
césures quand on les colle dans la partition. Les nouvelles options pour contrôler tout cela se
trouvent dans la pages Autres de Fichier > Préférences (dans le menu Sibelius sur Mac).

* Si vous tapez les paroles vous-même, Sibelius vérifiera que vous divisez les syllabes à la bonne
place, cf. Extensions à la page 51.

* Tous les styles de texte de paroles peuvent être créés directement à partir du menu Insertion >

Texte > Paroles.

Parties dynamiques
* La page Paramètres du document de Présentation des parties multiples comporte désor-

mais un bouton Marges, qui permet à l’utilisateur de régler directement les marges de la page et
des portées d’une ou plusieurs portées. Du coup, l’option (en anglais dans Sibelius 4) Lower first
system by n spaces de la page Layout de la même boîte de dialogue a été enlevée.

* Les nouvelles options de la page Mise en page de Présentation des parties multiples per-
mettent de déterminer si et comment des sauts de page spéciaux doivent apparaître dans les par-
ties dynamiques.

* Copier la mise en page des parties copie maintenant le format de page, la taille des portée, les
marges de pages et de portées, la distance entre les portées et les systèmes (tels que définis dans
la page Portées de Style maison > Règles de gravure), les changements de numéros de page et
les sauts de page spéciaux.

* Les parties dynamiques réglées sur orientation en portrait s’impriment désormais correctement
quand la partition est réglée sur paysage (Windows uniquement).

Portées en vue ciblée
Mise en page > Portées en vue ciblée a été déplacé dans Affichage > Portées en vue ciblée.

Saisie des notes
* La nouvelle option Rétablir les caractéristiques originales après sélection de mesure sim-

ple de la page Saisie de note de Fichier > Préférences (dans le menu Sibelius sur Mac), est
activée par défaut. Si vous la désactivez, Sibelius ne rétablira pas les indications de mesure, les
armures, clefs et changements d’instrument, etc.. si la sélection est longue d’une mesure ou plus
courte qu’une mesure.

* Si vous désactivez Jouer les notes en cours de modification de la page Saisie de note de
Fichier > Préférences (dans le menu Sibelius sur Mac), Sibelius restera complètement silen-
cieux pendant la saisie ou l’édition des notes via la saisie à la souris, la saisie alphabétique ou en
en mode pas-à-pas. Les notes ne seront exécutées que durant la saisie en mode Flexi-time ou
lors de l’exécution.

* Sibelius ne plante plus si trop de notes sont ajoutées à un accord en utilisant les touches des chif-
fres du clavier principal.

Sauts
* Vous pouvez désormais importer des pages blanches n’importe où en quelques clics en utilisant

la nouvelle fonction Mise en page > Sauts > Sauts de pages spéciaux (raccourci
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Ctrl+Maj+Retour ou xXRetour), puis ajouter du texte, des images, etc... pour produire des
pages de titre et des instructions d’exécution.

* Les pages blanches fonctionnent aussi dans les parties – en fait, vous pouvez les faire apparaître
soit dans le conducteur, soit dans les parties ou les deux en même temps.

* Les sauts de page spéciaux vous permettent de modifier les marges de page et de portée sur les
pages suivantes –cf. Paramètres du document ci-dessus.

* Les indications de mise en page (c’est-à-dire les sauts de systèmes, les sauts de page, les icônes de
sauts de page spéciaux) peuvent désormais être sélectionnées de manière à pouvoir être
supprimées.

* La nouvelle boîte de dialogue Insertion > Page de titre, vous permet de créer une ou plusieurs
pages blanches au début de la partition et d’y ajouter automatiquement un titre, le nom du com-
positeur, etc...

Styles maison 
* Quand on importe un style maison dans une partition, Sibelius prend désormais des décisions

plus intelligentes concernant la fusion du style nouveau et celui déjà existant dans la partition de
destination:
% Tous les styles obligatoires du style maison (par exemple les styles de texte par défaut, les

instruments par défaut, les symboles par défaut, aucun ne pouvant être supprimé) rempla-
cent les styles correspondants dans la partition de destination.

% Tout style défini par l’utilisateur dans le style maison qui correspond complètement à un style
déjà existant dans la partition de destination ne sera pas importé (pour éviter la prolifération
de styles identiques).

% Tout style défini par l’utilisateur dans le style maison qui, soit n’existe pas dans la partition de
destination ou dont le nom correspond à un style existant mais pas les caractéristiques, sera
ajouté aux styles de la partition de destination (pour éviter de réécrire un style défini par
l’utilisateur en un style qui ne lui correspond pas).

* Ces changements s’appliquent aussi lors de copier-coller entre partitions – cf. Sélections et
passages ci-dessus.

* De plus, il est maintenant possible d’importer par exemple un seul style de texte ou un seul sym-
bole par copier-coller d’un élément d’une partition à l’autre, ce qui permet de n’importer que les
styles nécessaires pour représenter l’élément collé. Cela permet de fusionner différents éléments
de plusieurs partitions et/ou de styles maison différents en un seul style maison “maître”.

* L’option d’importer des Types de portée d’un fichier de style maison a été remplacé par l’option
d’importation Définitions des instruments – cf. Modifier les types de portée et Portées
pour en savoir plus.

Symboles d’accord
Les menus contextuels des symboles d’accord ont été enrichis et offrent un meilleur accès aux
symboles d’accord qui suivent les différentes conventions à savoir:

* Les altérations de fondamentale sur la ligne de base plutôt qu’en exposant
* L’utilisation de +/- comme altérations superposables à la place des symboles de bémol et de dièse
* Des menus contextuels différents pour maj/min, ma/mi, les accords de type Brandt-Roemer, etc... 
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Tablature de guitare
Les chiffres de tablature de guitare au format de notes ornementales sont désormais correctement
alignés sur les chiffres de tablature de taille normale.

Têtes de note
De nouveaux types de tête de note peuvent désormais être incorporés aux partitions: 

* Les têtes de note de forme oblique ont été améliorées (têtes de note 3 et 4) au niveau de l’aligne-
ment avec les hampes

* Nouvelle tête de note en forme de grosse croix (tête de note 26) convenant pour les percussions
utilisés dans les défilés et jouant à l’unisson

* Nouvelles têtes de note de forme oblique (têtes de note 27 et 28) qui ressemblent aux têtes de
note 3 et 4 des anciennes versions, mais sont exécutées

* Nouvelle tête de note en forme de croix utilisant le double dièse comme symbole de croix (tête
de note 29)

* Nouvelle tête de note “ping” pour les percussions à sons indéterminés (tête de note 30).

Comme Sibelius ajoute automatiquement les têtes de notes dans les partitions existantes, leur
nombre peut être différent; pour vérifier quelles têtes de note figurent dans une partition spéci-
fique, utilisez Style maison > Modifier les têtes de note.

Ouverture de fichier MusicXML 
La qualité de la conversion des fichiers MusicXML a été spectaculairement améliorée dans Sibelius 5:

* La boîte de dialogue Ouvrir un fichier MusicXML a été revue de manière à rendre les options
plus évidentes et de nouvelles options ont été ajoutées pour permettre de choisir si la mise en
page et la mise en forme du fichier MusicXML file doivent être conservées.

* Sibelius peut maintenant ouvrir les fichiers MusicXML 2.0, à la fois dans les formats non com-
pressé (.xml) et compressé (.mxl).

* La mise en page et la mise en forme est importée de manière beaucoup plus précise dans le cas
de fichier MusicXML 1.1 ou supérieur, en incluant l’espacement des portées, les portées mas-
quées, les trémolos, les pages blanches, les mesures de comptage, etc...

* Sibelius importe désormais plusieurs types de notations des fichiers MusicXML, telles que les
portées de percussion à sons indéterminés, les diagrammes d’accord de guitare, les types de tête
de note, les objets masqués, les multiplets imbriqués, les armures de précaution, etc...

* L’importation des objets textuels des fichiers MusicXML est sensiblement améliorée en incluant
la police, la taille du point, la position du texte et des lignes, les textes attachés à la page (tels que
les en-tête, les numéros de page, etc...) les numéros de mesure, etc...

* Différents problèmes liés à la détermination correcte des longueurs de mesure dans les fichiers
MusicXML (en relation avec les différentes manières de décrire les multiplets, au nombre de
voix, aux ligatures enjambant les portées, aux notes ornementales, etc...) ont été résolus. En effet,
bien que d’apparence correcte certaines mesures, dès qu’elles étaient éditées, n’avaient plus la
longueur exacte.
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Percussion
* Quand on édite une table d’assignation des têtes de notes pour les sons de percussion dans la

boîte de dialogue Modifier les types de portées (auquel on accède via Style maison > Modi-
fier les Instruments), le son des percussions n’est plus choisi dans une liste prédéfinie de sons
de percussion General MIDI ou à une hauteur MIDI spécifique. À la place, l’assignation se
définit maintenant par le nouveau son ID du SoundWorld, qui décrit plus précisément les dif-
férents sons de percussion disponibles dans les instruments logiciels et matériels actuels.

* Vous pouvez maintenant faire une combinaison de tête de note et d’articulation sur une portée
de percussion pour obtenir des sons spécifiques, par exemple les sons ouverts et fermés que
jouent en alternance un charleston.

Portées
* Insertion > Autre > Changement de type de portée a été enlevé de Sibelius. Pour changer le

type de portée d’un instrument existant, les utilisateurs doivent désormais utiliser Insertion >

Changement d’instrument pour changer d’instrument avec le type de portée approprié – cf.
Changement d’instrument à la page 44.

Préférences
* Une nouvelle page Périphériques de saisie a été ajoutée au Fichier > Préférences (dans le

menu Sibelius sur Mac). Cette page contient certains contrôles qui étaient utilisés dans la page
Périphériques de saisie de Exécution > Périphériques d’exécution et de saisie, qui a été
supprimée. Les autres contrôles se trouvent désormais dans la page Saisie des notes de
Fichier > Préférences.

* Une nouvelle page Exécution a été ajoutée dans Fichier > Préférences (dans le menu Sibelius
sur Mac). Cette page contient certains des contrôles utilisés dans la boîte de dialogue
Exécution > Interprétation, et d’autre options supplémentaires semblables à celles qui figu-
raient dans Sibelius 4 (en anglais uniquement) en tant que Kontakt Player Options de Play >

Playback and Input Devices 
* Les installations pour plusieurs utilisateurs de Sibelius (numéros de série commençant par

SCxF, SCxM, SCxW) peuvent désormais voir leurs préférences écrites dans un espace global
commun à tous les utilisateurs et géré par un administrateur, de sorte que chaque compte d’uti-
lisateur aux privilèges limités n’a pas à régler ces préférences chaque fois que l’application est
lancée.

Propriétés
* Le panneau Portées de la fenêtre des propriétés a été enlevé:

% La case de contrôle Petite portée se trouve désormais dans Insertion > Instruments.
% Changer la tessiture de l’instrument se fait maintenant dans la nouvelle boîte de dialogue

Modifier les instruments accessible via Style maison > Modifier les Instruments.
% Pour changer le type de portée initial d’une portée, utilisez Insertion > Autre > Changement

d’instrument pour changer l’instrument initial d’une portée, ce qui change aussi le type de
portée.

* Le panneau Général des propriétés affiche désormais et de manière fort utile le numéro de la
page de la sélection en cours.
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* Le panneau Lignes des propriétés possède de nouveaux contrôleurs pour ajuster les ouvertures
des soufflets individuels – cf. Lignes ci-dessus.

* Le panneau Exécution des propriétés possède de nouveaux contrôleurs pour ajuster l’exécution
des soufflets et des trilles.

Sélections et passages
* La boîte de dialogue Édition > Sélectionner > Sélectionner des mesures (raccourci

Ctrl+Alt+A or zXA) permet de réaliser rapidement une sélection allant de la mesure en cours
à une mesure éloignée ou jusqu’à la fin de la partition.

* Copier et coller un élément entre partitions ne créera que les styles de texte, les styles de ligne,
les types de portée et les types de tête de note et les symboles utilisés dans le matériel copié et
n’entraîne plus l’importation du style maison de la partition d’où provient l’élément copié.

* Si un élément destiné à être collé comporte un style défini par l’utilisateur (par exemple un style
de texte) qui a le même nom qu’un style dans la partition de destination du collage, mais si ces
deux styles diffèrent dans leur présentation (par exemple parce qu’ils utilisent des polices dif-
férentes), Sibelius créera un nouveau style défini par l’utilisateur avec un nom différent dans la
partition de destination plutôt que de coller les objets suivant le style existant.

* Édition > Sélectionner > Plus sélectionne maintenant tous les numéros de mesure sur un
système si au départ un numéro de mesure est sélectionné.

* Copier un groupe de notes qui dépasse d’une barre de mesure n’efface plus les notes qui suivent
le groupe collé dans la mesure de destination.

Symboles
* La liste de symboles de Insertion > Symboles s’ouvre maintenant sur la rangée correcte quand la

boîte est réouverte ce qui permet de visualiser le symbole précédemment sélectionné.
* Ont été ajoutés plus de 180 nouveaux symboles, dont des symboles de musique ancienne, des

flèches, des clusters, des symboles supplémentaires de direction, etc.. – cf. Reprise et les
autres polices à la page 48.

Texte
* Les menus contextuels (qui apparaissent avec clic-droit (Windows) ou Contrôle-clic (Mac) lors

de la saisie des textes) sont désormais plus grands par défaut. Vous pouvez maintenant ajuster la
taille de la police des menus contextuels dans la page Menus contextuels de Fichier >
Préférences (dans le menu Sibelius sur Mac).

* Les textes peuvent désormais être réglés en taille de note de réplique en les sélectionnant et en
tapant le bouton “note de réplique” du pavé ou en activant la case de contrôle Taille de réplique
dans le panneau Général des propriétés.

* Sibelius comporte désormais un nouveau type de texte en plus des textes de portée et de
système: le texte de page blanche. Ce type de texte ne peut être créé que sur des pages blanches
créées en utilisant des sauts de page spéciaux.

* Le sous-menu Insertion > Texte a été réorganisé, avec tous les styles de texte pour les paroles
regroupés dans le nouveau sous-menu Insertion > Texte > Paroles et les nouveaux style de texte
de page blanche dans le nouveau sous-menu Insertion > Texte > Texte de page blanche.
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* Les textes qui se répètent sur plusieurs pages mais qui sont réglés de manière à ne pas s’afficher
sur la première page (c’est-à-dire la page à laquelle ils sont attachés), tel que En-tête (après la
première page), apparaissent désormais sur la première page mais masqués. Cela facilite la
création de ce type de texte (car il n’est pas évident d’afficher en même temps la page à laquelle
ce type de texte est attaché et la page suivante sur laquelle il apparaît réellement).

* Les formules magiques \$Time\ et \$FileDate\ produisent l’heure dans le format local correct
(Mac uniquement).

Transposition
* Notes > Transposition permet désormais de choisir une armure de transposition comme alter-

native à la transposition spécifiée en termes d’intervalles.
* La nouvelle option Changer l’armure au début de Notes > Transposition ajoute automatique-

ment une nouvelle armure au début d’une sélection quand un passage de système est transposé

Trémolos
Vous pouvez maintenant définir le comportement de chaque type de trémolo sur note individuelle
et de roulement (“z sur la hampe”) dans la page Articulations de Exécution > Dictionnaire.

Triolets et autres multiplets
* Sibelius comporte désormais un ensemble d’extensions destinés à rendre plus facile l’édition des

multiplets – cf. Extensions à la page 51 pour en savoir plus.
* Quand les multiplets sont en taille de note de réplique, leur crochet et leur chiffre sont désormais

aussi à la bonne taille.

Vidéo
* La précision de la synchronisation entre l’exécution et les fichiers de vidéo attachés a été

améliorée.
* Maj-[ et Maj-] font avancer la vidéo d’une image à la fois quelque soit la vitesse d’image, y com-

pris celle au format 29.97 non-drop.
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Annexe A: améliorations apportées 
jusqu’à Sibelius 4.1.5

Ce qui suit est une liste des améliorations les plus importantes apportées jusqu’à Sibelius 4.1.5. En
général, les bogues résolus ne sont pas mentionnés.

Les améliorations sont notées (v2), (v3) ou (v4), en fonction de la version sous laquelle elles ont été
ajoutées. Si vous faites la mise à jour depuis 1.x, outre les nouvelles fonctions de Sibelius 5, cela fait
plus de 600 améliorations introduites dans Sibelius 2, Sibelius 3 et Sibelius 4.

Pour en savoir plus, veuillez consulter la section de référence de Sibelius qui convient.

Fonctions Améliorations

Altérations Meilleure position des altérations dans les accords (v2), et possibilité de les masquer (v3).

Armures Différentes armures sur différentes portées (v2)

Arrange™ Gain de temps pour arranger et orchestrer grâce à la copie intelligente dans plus de 140 styles pro-
posés (dont “distribution” et “réduction”), et la possiblité de créer son propre style (v2)

Articulations Les articulations peuvent être inversées, sont automatiquement positionnées à l’extrémité des hampes 
des notes et sont centrées sur cette extrémité (v2)

Barres de mesure Barres de mesure pour la musique ancienne (entre les portées, quart de barre, demi-barres) et option 
pour régler les types de barre par défaut (v2)

Code temporel Affichage du tempo et du code temporel sur la barre d’outils durant l’exécution; calcul, affichage et 
impression de la durée totale de la partition; indication des codes temporels au-dessus de chaque 
barre de mesure dans différents formats (v2); prise en compte des reprises (v3); nouvelles vitesses 
d’images (v4); styles de texte spécifiques pour le code temporel et les points de montage (v4)

Couleur Changer la couleur de pratiquement tout objet dans la partition (v3)

Créateur d’exercices Choix parmi plus de 1700 exercices prêts à l’emploi, projets, exercices, chansons, morceaux instru-
mentaux, posters, matériaux de référence et autres ressources (v4).

Crochets et accolades Crochets et accolades masqués si aucune barre de mesure ne figure à gauche du système (v3)

Diagrammes d’accord Les diagrammes d’accord (grilles pour la guitare) peuvent être transposés, et conservés dans des bibli-
othèques pour faciliter l’échange (v3); les diagrammes d’accords peuvent afficher des doigtés au-des-
sus ou en dessous (v4)

Édition sur Internet Scorch sur Mac possède un curseur de tempo (v4); exécution et impression des images en couleur 
améliorée (v2); possibilité de choisir si les visiteurs de votre site web peuvent imprimer et sauvegarder (v2)

Espacement des notes L’espacement optique des notes évite les collisions, améliore l’espacement des multiplets, etc. (v3)

Espacement des portées La boîte de dialogue aligner les portées permet de positionner les portées précisément à travers toute 
la partition; les réglettes de portée affichent les distances entre les portées; des raccourcis-clavier per-
mettent de déplacer les portées (v2)

Exécution Sont exécutés les rit., accel., glissandos, bends et slides de guitare (v2), les structures de reprise compli-
quées (D.C., D.S., Coda, etc.), les modulations métriques, etc... (v3); nouvelle fenêtre de l’exécution (v4)

Exécution enregistrée Reproduit la durée et les nuances saisies via Flexi-time ou par importation d’un fichier MIDI, avec 
possibilté d’ajuster l’interprétation de manière très fine (v3)

Exportation de fichier 
audio

Avec Kontakt Silver ou Gold, Sibelius peut sauvegarder des fichiers audio numériques de votre parti-
tion prêts à être gravés sur CD (v3)

Exportation des images Copier et coller des images vers d’autres applications (v4); polices incluses dans les fichiers EPS, et 
choix automatique du format d’exportation le plus approprié vers le programme choisi (v2)

Extensions Plus de 60 nouvelles extensions dont, réaliser des symboles d’accord (v3), copier des articulations et 
des liaisons (v4), ajouter une harmonie élémentaire (v4), détection et décompte (v4), etc.
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Fichiers Nouvelle boîte de démarrage rapide qui apparaît au lancement du programme (v3); nouvelle boîte de 
dialogue de création de partition pour contrôler le processus en cinq étapes (v3); possibilité d’exporter 
des partitions au format Sibelius 2, Sibelius 3, G7 et Sibelius Student

Fichiers de tablatures 
ASCII

Importation et exportation des fichiers de tablature au format ASCII (v3)

Filtres et recherche Nouvelle boîte de dialogue de filtre évolué et boîte de dialogue de recherche / recherche suivante, ainsi 
que beaucoup de nouveaux “filtres rapides” (v2)

Flexi-time Scission automatique des notes sur deux voix et réglages d’enfoncement des touches personnalisables 
pour les staccato/tenuto (v3)

Importation d’images Importation d’images en couleur et en noir et blanc au format TIFF (v2)

Impression Impression d’un pied de page avec date et heure, nouveau mode d’impression face à face (2-up) (v4)

Instruments Sibelius reconnaît maintenant plus de 400 instruments différents (v3); les tessitures “confortable” et 
“professionnelle” sont affichées en deux teintes de rouge (v2). La boîte de dialogue Instruments per-
met de modifier l’ordre des portées après les avoir créées (v3)

Interprétation Nouvelles options de rubato et de style rythmique pour produire une exécution plus réaliste (v2)

Jeux de sons Intégration d’un éditeur de sons, qui permet aux utilisateurs de créer des sons pour les périphériques 
MIDI non reconnus (v3)

Kontakt Player Sibelius comporte un périphérique logiciel d’exécution des échantillons spécialement conçu par 
Native Instruments grâce auquel on obtient une exécution de très grande qualité (v3); des biblio-
thèques Sibelius Sounds supplémentaires peuvent s’acheter séparément (v4)

Langage ManuScript Un grand nombre d’améliorations apportées au langage de programmation intégré ManuScript

Liaisons rythmiques Les liaisons optiques produisent des liaisons au design parfait; les extrémités des liaisons rythmiques 
se déplacent comme on le souhaite (v4)

Lignes Nouvelles lignes de système pour l’exécution des rit./accel. (v2)

Masquer des objets Possibilité de masquer pratiquement n’importe quel objet de la partition, comme par exemple des 
répliques masquées dans le conducteur et présentes dans les parties séparées (v2)

Menu affichage Nouvelles options de note en couleur dont les notes en couleur d’après la voix, ou selon la “gamme co-
lorée” (couleur d’après la hauteur) (v2)

Menus et raccourcis Nouveaux raccourcis-clavier par défaut pour le clavier coloré Sibelius et pour les ordinateurs portables (v4)

Menu fenêtre Nouvelle option Fenêtre > Masquer les fenêtres des outils et nouveaux boutons de la barre d’outils 
pour les fenêtres d’outil (v4)

Mesures de silence Les mesures de silences occupent plus d’espace horizontal (v4)

Modifier les styles de 
texte

Nouvelle boîte de dialogue Modifier toutes les polices pour permettre le changement rapide de toutes 
les polices utilisées dans la partition (v3)

Numéros de mesures Les mesures de comptage peuvent afficher en-dessous l’étendue des mesures à compter, les numéros 
de mesure peuvent être déplacés et respectent les options de position horizontale du style de texte des 
numéros de mesure (v4)

Numéros de page Les numéros de page peuvent être alignés sur la marge des portées plutôt que sur la marge des pages (v3)

Numérisation PhotoScore Lite lit deux voix dans la même portée, peut agir sur des partitions transposées, lire des 
tablatures pour guitare (v3), et numériser et lire toutes les pages automatiquement (v4)

Référence de Sibelius Ouvrage de référence intégralement disponible à l’écran via Aide > Sibelius Référence (v4)

Ouvrir des fichiers MIDI Importation des marqueurs comme points de montage (v4); reconnaisance des multiplets améliorée (v4)

Ouvrir des fichiers XML Importation des fichiers MusicXML 1.1, ainsi que ceux créés par Finale 2003 ou une version ultérieure 
et par d’autres programmes musicaux (v4)

Portées Sibelius indique par une ligne pointillée bleue si une ou plusieurs portées sont masquées. Vous pouvez 
à présent indenter les systèmes à droite (v3)

Papiers à musique Plus de 60 papiers à musique prédéfinis

Fonctions Améliorations
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Paramètres du docu-
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Marges différenciables selon les pages de gauche/droite, nouvelle fonction “marges de portée” pour la 
position des portées relative aux noms des instruments (v2), nouveau format de page pour les parties (v4)

Paroles Copier et coller des paroles depuis et vers d’autres programmes, par exemple des traitements de texte (v2). 
Nouvelles options pour l’espacement des paroles et pour les paroles en langues d’extrême-orient (v3).

Parties dynamiques Les parties instrumentales sont conservées dans le même fichier que le conducteur, les changements 
dans la partition sont automatiquement reflétés dans les parties et vice-versa; impression automatique 
de toutes les parties; nouvelle boîte de dialogue Mise en page automatique pour installer des sauts 
de système ou de page automatiques (v4)

Percussion Nouvelle option pour le roulement (z sur la hampe), exécuté comme un trémolo non mesuré (v4)

Polices musicales Nouvelle police musicale Helsinki (v4); nouvelle police Opus Metronome, nouvelle police Opus Figu-
red Bass (v4); nouvelle police Inkpen2, en remplacement de l’ancienne police Inkpen (v2)

Portées en vue ciblée Masquer les portées qu’on ne souhaite pas voir (même si elles contiennent des notes) en laissant 
uniquement celles sur lesquelles on travaille (v3)

Propriétés Nouvelle fenêtre des propriétés avec 7 panneaux modulables permettant d’ajuster les objets individu-
ellement ou en groupes (v2)

Raccourcis-clavier Plus de 200 raccourcis-clavier au total – pratiquement tout est possible sans souris. Créer vos propres 
jeux de raccourcis-clavier, et désactiver les fonctions dont vous n’avez pas besoin (v3).

Réglages d’affichage Nouvelles options d’affichage optimisé, incluant OpenGL et Mac OS X (v3); nombreuses textures de 
haute qualité pour le bureau et le papier pour un environnement de travail plus agréable (v2); 

Saisie des notes Lors de la saisie des notes, un curseur s’affiche et avec le clavier de l’ordinateur on peut créer du texte, 
des indications de mesure, des accords, etc...; utiliser la copie multiple pour copier les nuances sur 
chaque portée d’un band/orchestre, ou remplir des mesures avec un ostinato, etc. (v2). “L’ombre des 
notes” affiche la hauteur de la note avant sa création, et on peut créer des notes n’importe où avec la 
souris. La fonction réentrer les hauteurs de notes permet de changer les hauteurs de notes existantes 
sans les resaisir (v3). L’écran se déplace moins fréquemment lors de la saisie des notes et de l’édition (v4).

Sauts Sauts de page automatiques pour les tournes aux silences dans les parties extraites (v3)

Style maison Le nouveau menu Style maison contient tous les réglages nécessaires pour ajuster la présentation des 
partitions (v2); un grand nombre de styles maison proposés, dont plusieurs qui utilisent des polices de 
texte différentes (v4)

Surlignage Effet de marqueur surligneur pour indiquer des passages (v2)

Symboles Nombreux symboles ajoutés. Les symboles peuvent être attachés aux systèmes comme aux portées (v3).

Symboles d’accord Nouveaux caractères dans les polices Inkpen2 Chords et Opus Chords, nouvelles polices Opus Roman 
Chords et Opus Japanese Chords (v4)

Tablature de guitare Reconnaissance (et exécution) des indications de tablature de guitare tels que les bends, les slides, 
etc... Nouvelle méthode de saisie des tablatures avec le clavier, nouveaux types de portées de tablature, 
nouvelles options pour les longueurs des hampes dans les tablatures (v2).

Table de mixage La fenêtre modulable Table de mixage remplace la boîte de dialogue Sons, et permet d’ajuster l’exécu-
tion en temps réel (v2)

Têtes de note Plus de 24 types de tête de note par défaut dont des têtes silencieuses ou sans hampe (v3)

Texte Le texte peut recevoir une taille fixée indépendamment de la taille de la portée, grâce à des formules 
magiques les éléments entrés dans Fichier > Infos sur la partition peuvent être installés automa-
tiquement dans certains objets textuels de la partition; améliorations apportées aux menus contextu-
els, reconnaissance intelligente de la basse chiffrée (v4)

Trémolos Options du style maison pour la présentation des trémolos (v2); Option dans les propriétés pour exé-
cuter ou non un trémolo (v4)

Triolets & multiplets Multiplets “magnétiques”, qui se positionnent intelligemment comme les liaisons (v2)

Vidéos d’apprentissage 20 vidéos d’apprentissage aux principales fonctions de Sibelius (v4)

Vidéo Ajouter une vidéo à la partition, synchronisée durant l’exécution, permettant d’écrire de la musique de 
film (v4)

Fonctions Améliorations
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Annexe B: changements dans les menus

Le tableau ci-dessous énumère tous les menus de Sibelius 4 qui ont changé dans Sibelius 5. Par
contre n’y figurent pas les nouveaux éléments qui apparaissent dans les menus.

Voici les principaux changements de Sibelius 3 vers Sibelius 4:

* Sibelius 4 possède une boîte de dialogue Fichier > Préférences de plusieurs pages (dans le menu
Sibelius sur Mac), qui combine plusieurs boîtes de dialogues de Sibelius 3, dont Affichage >

optimisé et Affichage > Textures, ainsi que de nouvelles options
* Toutes les opérations d’exportation des fichiers – par ex. sauvegarder dans des formats antérieurs

de Sibelius, ou sous forme de fichiers MIDI ou d’images, etc... – se font via le sous-menu Fichier >
Exporter, plutôt que via Fichier > Sauvegarder sous

* Style maison > Utiliser des mesures de comptage a été déplacé dans la boîte de dialogue Mise en
page > Mise en page automatique, mais le raccourci Ctrl+Maj+M ou xXM fonctionne toujours.

Voici les principaux changements de Sibelius 2 vers Sibelius 3:

* La liste des fichiers ayant fait l’objet d’une session de travail récente a été déplacée dans le sous-
menu Fichiers > Ouvrir des fichiers récents et peut contenir jusqu’à 10 fichiers

* Le menu Insertion a été simplifié, en déplaçant ce qui est moins utilisé dans le sous-menu
Insertion > Autre.

Voici les principaux changements de Sibelius 1.x vers Sibelius 2:

* Flexi-time se trouve dans le menu Notes 
* Espressivo, Swing et Reverb se trouvent dans la boîte de dialogue Exécution > Interprétation 
* Plusieurs éléments du menu Affichage se trouve dans le menu Fenêtre

* Apparition du nouveau menu Style maison qui permet de modifier tous les aspects du style
maison d’une partition. L’ancienne boîte de dialogue Style maison s’appelle désormais Règles
de gravure.

Sibelius 4 Sibelius 5

Insertion > Autre > Changement de type de portée Remplacé par Insertion > Autre > Changement d’instrument.

Insertion > Autre > Changement de transposition Remplacé par Insertion > Autre > Changement d’instrument.

Exécution > Pé’riphériques de substitution Supprimé.

Exécution > Périphériques de saisie et d’exécution Les options de périphériques d’exécution se trouvent désormais 
dans Exécution > Périphériques d’exécution; les options de 
périphérique de saisie sont à la page Périphériques de saisie de 
Fichier > Préférences (dans le menu Sibelius sur Mac)

Exécution > Modifier les jeux de sons Supprimé.

Exécution > Options de Garritan Personal Orchestra Supprimé.

Mise en page > Portées en vue ciblée Affichage > Portées en vue ciblée

Mise en page > Instrument and Staves Insertion > Instruments

Style maison > Modifier les types de portée Supprimé; remplacé par Style maison > Modifier les instruments.

Window > Kontakt Player Supprimé; remplacé par des fenêtres d’instruments virtuels qui 
peuvent apparaître dans la table de mixage.
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Annexe C: raccourcis-clavier

Voici la liste des nouveaux raccourcis de Sibelius 5 et ceux existants qui ont changés.

Nouveaux raccourcis-clavier
Le tableau ci-dessous donne la liste de tous les nouveaux raccourcis-clavier de Sibelius 5:

Raccourcis changés par rapport aux versions anciennes
Voici les changements de raccourcis-clavier depuis les versions précédentes vers Sibelius 5.

Raccourcis changés depuis Sibelius 1.x shortcuts
Il y a beaucoup de raccourcis modifiés depuis Sibelius 1.x. Pour avoir la liste complète de tous les
raccourcis utilisés désormais dans Sibelius, b 5.10 Menus et raccourcis dans référence.

Fonction Raccourcis Windows Raccourcis Mac

Édition > Capturer une idée Maj-I xI

Édition > Coller en tant que réplique Ctrl+Maj+Alt+V xzXV

Édition > Sélectionner> Sélectionner des mesures Ctrl+Alt+A zXA

Édition > Supprimer des mesures Ctrl+Suppr X-Suppr

Affichage > Panorama Maj-P xP

Mise en page > Saut > Saut de page spécial Ctrl+Maj+Retour xXRetour

Fenêtre > Idées Ctrl+Alt+I zXI

Fonction Avant Sibelius 5

Changements pour les raccourcis de Sibelius 4 

Exécution > Interprétation Maj-P Aucun raccourci

Changements pour les raccourcis de Sibelius 3

Marche arrière/marche avant rapide 0/1 [ / ]

Édition > Masquer ou afficher> Afficher Ctrl+Maj+S ou xXS Ctrl+Maj+H or xXH

Fenêtre > Table de mixage (Mac uniquement) zXM M

Raccourcis pour utiliser le pavé sur le portable (Windows unique-
ment)

Ctrl+Alt+Q/W/E/R/A/
S/D/Z/X/C/R

remplacé par l’utilisation
du jeu de fonctions fonc-
tions du portable

Fichier > Extraire les parties Ctrl+Maj+X ou xXX Aucun raccourci

Changements pour les raccourcis de Sibelius 2

Affichage > Note en couleur > Notes hors de tessiture Ctrl+Alt+N ou zXN Aucun raccourci

Affichage > Note en couleur > Gamme colorée Ctrl+Alt+P ou zXP Aucun raccourci

Insertion > Diagramme d’accord (qui figurait dans Insertion >
Grille de guitare)

U Maj-K

Insertion > Texte > Indication métronomique Ctrl+M ou XM Aucun raccourci

Notes > Saisie des notes V N

Fenêtre > Propriétés Ctrl+I ou XI Ctrl+Alt+P ou zXP


	Introduction
	L’ouvrage de référence de Sibelius
	Dans votre emballage de mise à jour

	Installation
	Mise à jour sous Windows
	Important
	Configurations minimales requises
	Comment déterminer si vous êtes sous Windows XP Service Pack 2
	Utilisateurs Sibelius 1.x
	Plusieurs exemplaires et licences réseau
	Privilèges d’administrateur
	Installer votre mise à jour
	Installer Sibelius Sounds Essentials
	Installer Scorch
	Installer PhotoScore Lite
	Mise à jour de produits Sibelius Sounds
	Premier lancement
	Restaurer d’anciens fichiers
	Désinstaller des versions anciennes de Sibelius

	Mise à jour sur Mac
	Important
	Configurations minimales requises
	Comment déterminer si vous êtes sous Mac OS X 10.4 Tiger ou plus
	Plusieurs exemplaires et licences réseau
	Privilèges d’administrateur
	Installer votre mise à jour
	Installer Sibelius Sounds Essentials
	Installer Scorch
	Installer PhotoScore Lite
	Mise à jour de produits Sibelius Sounds
	Premier lancement
	Restaurer d’anciens fichiers
	Désinstaller des versions anciennes de Sibelius

	Mise à jour de partitions existantes
	Changements automatiques
	Changements d’instrument dans les partitions existantes
	Exécution de partitions existantes
	Importer un style maison

	Mise à jour depuis Sibelius 1.x
	La saisie des notes
	Créer des objets sans la souris
	Sélectionner l’emplacement de création d’un objet


	Quoi de neuf?
	Exécution
	Vidéos d’apprentissage
	Sibelius Sounds Essentials
	Kontakt Player 2
	Autres produits Sibelius Sounds
	Périphériques d’exécution
	Table de mixage
	Des fichiers audio produits plus vite et mieux
	Dictionnaire de l’exécution
	Soufflets et trilles
	SoundWorld
	Autres améliorations pour l’exécution
	Dossier instruments virtuels et effets (Windows uniquement)

	Idées
	Vidéo d’apprentissage
	Qu’est-ce qu’une idée
	La fenêtre des idées
	La fenêtre des idées peut s’afficher sous deux formes différentes, compacte et détaillée. Par défaut, elle s’ouvre en affichage compact, qui a l’aspect suivant
	Écouter une idée
	Capturer une idée
	Pour créer une idée, sélectionnez quelque chose dans la partition et choisissez Éditer > Capturer une idée (raccourci Maj-I). Vous pouvez capturer une idée à partir de tout type de sélection, à savoir:
	Rechercher une idée
	Coller une idée
	Idées prédéfinies
	Éditer une idée
	Où les idées sont-elles sauvegardées?
	Partager des idées
	Importer des idées

	Panorama
	Vidéo d’apprentissage
	Activation de Panorama
	Se déplacer dans Panorama
	Saisie et édition dans Panorama
	Espacement des notes dans Panorama
	Espacement des portées dans Panorama
	Utilisation de Panorama en combinaison avec Portées en vue ciblée
	Ouverture de partitions dans Panorama

	Répliques
	Coller en tant que réplique
	L’extension proposer des répliques
	L’extension vérifier les répliques
	Préférences de coller une réplique
	Masquer les portées vides

	Instruments
	Changement d’instrument
	Modifier les instruments
	Insérer des instruments

	Numérotation
	Numéros de mesure
	Changements de numéros de mesure
	Nouvelles règles de gravure pour les numéros de mesure
	Aller à la mesure
	Numéros de page
	Repères de répétition

	Reprise et les autres polices
	Reprise™
	Opus Note Names
	Symboles d’accord
	Musique ancienne & d’avant garde
	Analyse fonctionnelle
	Autres améliorations

	Extensions
	Symboles d’accord
	Divers
	Exécution
	Corrections d’épreuves
	Simplifier la notation
	Texte
	Multiplets
	Autres extensions mises à jour

	Interface
	Barre d’outils
	Menus
	Raccourcis-clavier
	Saisie des notes
	Navigateur
	Améliorations supplémentaires sur Mac
	Autres améliorations

	Autres améliorations et bogues résolus
	Aide
	Altérations
	Armures
	Articulations
	Clefs
	Exporter des fichiers audio
	Exporter des fichiers d’images
	Exporter des fichiers MIDI
	Fichiers
	Filtres
	Indication de mesure
	Imprimer
	Importer des images
	Importer des fichiers MIDI
	Installer Sibelius
	Interprétation
	Ligatures
	Lignes
	Masquer les objets
	Menu affichage
	Menu fenêtre
	Mesures de comptage
	Mesures et mesures de silence
	Modifier les jeux de sons
	Modifier les types de portée
	Modifier les styles de textes
	Modifier les symboles
	Numérisation
	Papiers à musique
	Paramètres du document
	Paroles
	Parties dynamiques
	Portées en vue ciblée
	Saisie des notes
	Sauts
	Styles maison
	Symboles d’accord
	Tablature de guitare
	Têtes de note
	Ouverture de fichier MusicXML
	Percussion
	Portées
	Préférences
	Propriétés
	Sélections et passages
	Symboles
	Texte
	Transposition
	Trémolos
	Triolets et autres multiplets
	Vidéo


	Annexes
	Annexe A: améliorations apportées jusqu’à Sibelius 4.1.5
	Annexe B: changements dans les menus
	Annexe C: raccourcis-clavier
	Nouveaux raccourcis-clavier
	Raccourcis changés par rapport aux versions anciennes
	Raccourcis changés depuis Sibelius 1.x shortcuts




<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /None
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Error
  /CompatibilityLevel 1.4
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJDFFile false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /SyntheticBoldness 1.00
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveEPSInfo true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile ()
  /PDFXOutputCondition ()
  /PDFXRegistryName (http://www.color.org)
  /PDFXTrapped /Unknown

  /Description <<
    /ENU (Use these settings to create PDF documents with higher image resolution for high quality pre-press printing. The PDF documents can be opened with Acrobat and Reader 5.0 and later. These settings require font embedding.)
    /JPN <FEFF3053306e8a2d5b9a306f30019ad889e350cf5ea6753b50cf3092542b308030d730ea30d730ec30b9537052377528306e00200050004400460020658766f830924f5c62103059308b3068304d306b4f7f75283057307e305930023053306e8a2d5b9a30674f5c62103057305f00200050004400460020658766f8306f0020004100630072006f0062006100740020304a30883073002000520065006100640065007200200035002e003000204ee5964d30678868793a3067304d307e305930023053306e8a2d5b9a306b306f30d530a930f330c8306e57cb30818fbc307f304c5fc59808306730593002>
    /FRA <>
    /DEU <>
    /PTB <>
    /DAN <>
    /NLD <>
    /ESP <>
    /SUO <>
    /ITA <>
    /NOR <>
    /SVE <>
    /KOR <>
    /CHS <FEFF4f7f75288fd94e9b8bbe7f6e521b5efa76840020005000440046002065876863ff0c5c065305542b66f49ad8768456fe50cf52068fa87387ff0c4ee575284e8e9ad88d2891cf76845370524d6253537030028be5002000500044004600206587686353ef4ee54f7f752800200020004100630072006f00620061007400204e0e002000520065006100640065007200200035002e00300020548c66f49ad87248672c62535f0030028fd94e9b8bbe7f6e89816c425d4c51655b574f533002>
    /CHT <FEFF4f7f752890194e9b8a2d5b9a5efa7acb76840020005000440046002065874ef65305542b8f039ad876845f7150cf89e367905ea6ff0c9069752865bc9ad854c18cea76845370524d521753703002005000440046002065874ef653ef4ee54f7f75280020004100630072006f0062006100740020548c002000520065006100640065007200200035002e0030002053ca66f465b07248672c4f86958b555f300290194e9b8a2d5b9a89816c425d4c51655b57578b3002>
  >>
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice


